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Chapter 1

Introduction 

Welcome to FastRIP 10.0
Congratulations on purchasing FastRIP 10.0 or a FastT-Jet Inkjet-to-Garment Printer.

FastRIP is the heart of the printing process, performing the task of a Raster Image Processor 
(RIP), controlling how much ink is laid down, how many passes are made by the Print Head and 
how White ink is printed.

FastRIP performs high-speed memory management of the raster image and the spooling of 
multiple jobs to the printer by utilizing Virtual Memory (VM) disk processing. VM Processing 
means PostScript file size limitations have been nearly eliminated while also supporting up to 
PostScript Level 3 images.

Enhancing and streamlining your T-Jet Printer from any application, FastRIP allows you to 
print the most vibrant prints possible on both light and dark garments. The media profiles (print 
modes) provided with FastRIP can be automatically applied by selecting the print mode that best 
corresponds to the loaded media, image resolution, etc.

FastRIP 10.0 is MORE THAN JUST A RASTER IMAGE PROCESSOR!
The new FastRIP 10.0 is a printing program in itself offering several different functions and tools 
that have never been included in the past. 

The new 10.0 version has also been developed to incorporate screen print positive printing in 
conjunction with using an Epson Printer. Some features of FastRIP 10.0 may only apply to 
inkjet-to-garment printing and some only to printing screen print film positives. 

NOTE: It is expected that you have read and understood the Users’s Manual that was provided with your T-Jet  
printer, and that you are aware of the printer’s capabilities. Regardless, once you have installed FastRIP and 
performed a test print, return to this manual and review the workflows contained herein to help you understand 

the FastRIP features.
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Twelve New Features of FastRIP 10.0
As mentioned earlier, FastRIP 10.0 is MUCH more than just a Raster Image Processor. Below is 
a list of the new Features that will help you glide through the printing process.

1. New Queue and Production Manager

A completely new queue design with Visual Production Manager capabilities for layout and 
many other custom settings.

2. Multiple Queues with Queue Tabs

This new feature allows you to setup a 
queue for white shirts and another for 
black shirts or a queue for Sleeves and 
Non-textiles etc. Plus, each queue can be 
access directly from FastARTIST or the 
printer control panel from any application.

3. Underbase From FastRIP
FastRIP 10.0 has a built in 
automatic underbase for trans-
parency images. This means, 
you no longer need to use 
FastARTIST or the Windows 
underbase methods for creat-
ing your underbase. PhotoShop 
users can work with or without 
FastARTIST. This new feature 
supports trapping, highlight 
white settings and more.

4. Advanced Visual Production Manager Controls

Advanced controls let you specify page copies (for multiple shirts) or copies for same pass (such 
as gold balls). New Media setup includes special support for flatbeds like the 
T-Jet. You can visually size and position each job directly inside of the FastRIP window. You can 
also Crop and Tile of Jobs from FastRIP. The new version 10.0 also allows you to Nest jobs, mul-
tiple job / shirt boards in the Queue.
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5. Pre-made and Custom Templates

This new feature allows you to 
create and position print ar-
eas. Use the Template Creation 
window to create and setup your 
own shirt boards. The templates 
Can be used for 3 UP (Blazer 
Pro) meaning you no longer 
need to lay out 3 shirts in your 
graphics program. FastRIP will 
automatically layout the jobs 
in FastRIP. When loading a job 
into FastRIP, you can tell it to 
load the same image to all 3 shirt 
boards or to load the next im-
ported job into the second shirt 
board and so on.

This can be extremely useful for printing such things as golf balls. The image only needs to be 
imported once. It is then duplicated for each printing area on the template. The template feature 
can even be used to print a pocket, full shirt and a cap at the same time (all using 1 image loaded 
into FastRIP). The possibilities are virtually endless. Template can also be utilized using the Hot 
folder support settings for batch processing (internet printing automation) used by Zazzle and 
other internet companies.

6. Costing Interface

This new feature allows you to keep track of 
spending such as Exact Ink usage calculation, 
Material, Tax and Labor and more.  Export 
information to standard deli metered format, 
for use in Excel and other database programs. 

7. Drag and Drop Support

With Version 10.0, you can drag and drop 
your artwork directly into the FastRIP Queue 
for print settings and printing. 

8. FULL Hot Folders Support

This new feature includes Hot Folder and con-
trol panel access to all available Queues.
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9. Custom Job Preview Options

You can set and preview substrate color directly from the job preview window in FastRIP. You 
can also zoom in/out  and more.

10. PDF Support

The new version has full PDF support including full transparency and version 1.7 compatible 
(Acrobat 8).

11. Untagged Bitmap Support

Untagged Bitmaps are RawBitmap files. By using the Drag and Drop feature, tag untagged Bit-
maps automatically for direct Raw Bitmap printing.

12. New Background Knockout Plug-ins For PhotoShop

FastRIP 10.0 includes new and improved versions the popular PhotoShop Plug-ins, KnockMe-
BlackOut and KnockMeColorOut that has been included with FastARTIST software. The old 
versions only had the ability to knock out black or white backgrounds, but with the new update, 
you can knock out any color you want. Plus, you can visually see the effect on screen, with three 
different views:

Image with transparency``

The underbase``

Resulting image on shirt color (you can select shirt color) ``

You can also control the amount of underbase generated or color removed using a simple slider 
adjustment. For images already on a black background this provides a simple one step process for 
perfect results in FastRIP. 

Raster Image Processing
The term Raster Display originates from the method by which television images are created in 
a series of horizontal scan lines. Sixty times a second (60 Hz), these scan lines are rendered from 
top to bottom on a cathode-ray tube (CRT). This frequency is faster than the brain can process 
the information, thus allowing a sequence of still pictures to create the illusion of movement. 
Televisions and computer monitors are referred to as raster displays and the rectangular pattern 
of horizontal lines refers to a raster. 

A printer is also considered a raster display, since printing requires text and graphics to be trans-
lated into a rectangular pattern of horizontal lines. The printer will then lay ink upon the media 
for each raster line, rendering the final image. The process of creating a Raster from text and 
graphic elements is known as Raster Image Processing or  Rasterization.
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Supported Printers
FastRIP 10.0 supports all T-Jet Inkjet-to-Garment Printers. This list includes the T-Jet Blazer 
Series printers, T-Jet SDT-1000, T-Jet2 SDT 2200 and T-Jet3 Plus and 3300 models.

For purposes of using FastRIP 10.0 for printing screen print positives (RIP sold separately), it 
also supports the Epson Stylus Color 1520, 3000, R1400, R1800, R1900, R2400, the Epson 
Stylus Photo 2200 and the Epson Pro 4000, 4800, 4880, 7600, 7800, 7880, 9600, 9800 and 
9880.

Security Device Dongle
FastRIP is provided with a software protection device, called 
a “Dongle,” to prevent unauthorized use or pirating of the 
software. For a Windows/PC you can use either a USB or 
Parallel Port Dongle. You specified the type you wanted when 
you ordered the software. In either case, the Dongle is visible to 
FastRIP, yet remains transparent to other applications.

Policy On Lost Or Stolen Security Devices

The USB security device provided with FastRIP is your proof of purchase. ``
If the dongle is lost or stolen, then that is equivalent to losing the entire 
software package, and a new package of FastRIP must be purchased.

In the event of a damaged security device that must be replaced, there is a ``
nominal fee for EXCHANGING a new device for the older device, where 
the older device must be reclaimed. 
 
This fee is waived where product is still under warranty.

Regardless, it is recommended that you ensure that your security device is ``
covered under your business insurance policy. 

If the Dongle Does Not Work

If failure of the hardware (Dongle) has resulted from accident, abuse or misapplication, there
 should be no responsibility to replace the hardware. Replacement will be warranted for 
the remainder of the original warranty period or 1 (one) year, whichever is longer. If the Dongle 
ceases to operate within the warranty period, it will be replaced at no charge AFTER it has been 
returned.

You must insure the Dongle for at least $250 against loss or damage during mailing. If the 
Dongle is not under warranty, a replacement Dongle may be purchased. Contact us for 
pricing or for details on purchasing or returning a defective Dongle. All returns must be shipped 
with a traceable carrier and have a return authorization number on the box provided.
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FastRIP Manual
The electronic version of this Manual is on the FastRIP CD in a folder called FastRIP Manual. 
It is an Adobe Acrobat PDF file. If you don’t have Adobe Acrobat, there is a free version on the 
FastRIP CD.

FastRIP Support
Toll Free 			   +1 888-698-5387

Technical Support 		 +1 480-929-2937 
Corporate Office	  	 +1 480-929-0640 
Fax		  		  +1 480-929-0766 
E-mail: 			   support@usscreen.com

Internet: 			   www.screenprinters.net. Click on the Support tab.

Support hours: 		  7:00am to 5:00pm Monday through Friday  
 				     
 				    (Mountain Standard Time) USA

				    Emergency Support is also available.

Note: Arizona does not observe “Daylight Savings Time.”  
In the summer months, Arizona is on the same time as California.

Before calling, please make sure you have watched the video and read the entire Manual. If you 
are unable to find the answer to your questions in the Manual or the video, you can also visit the 
FastRIP User’s Arena on the internet at www.screenprinters.net and click on the Support tab. 
Here you will find news, Frequently Asked Questions, Public Documents, Technical Articles, a 
Support Request Form and downloads for the FastRIP program.

Support is provided only for the software application FastRIP and not for your Epson inkjet 
printer. Although we will try to assist you with printer problems, your best option is to contact 
the dealer from whom you purchased your Epson printer or call the manufacturer’s Technical 
Assistance.

Have your product serial number and history available when calling.
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PC System Requirements
FastRIP is a 32-bit Windows application. The following system configurations are the minimum 
requirements:

A PC equipped with a Pentium processor 1.25 GHz or higher``

At least 512MB of RAM; 1GB or more is highly recommended. (User’s ``
of Windows Vista will need and minimum of 2 GB of RAM for proper 
operation)

200MB free hard drive space recommended``

Windows Vista/XP/2000 Operating System``

USB 1.1 port (high speed 2.0 recommended)``
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Chapter 2

Installation
Basic Printer Setup

Please refer to your Inkjet-to-Garment Printer’s User’s Manual for setup and placement instruc-
tions. Have your printer setup prior to starting the installation of FastRIP.

 
 

Computer Connections
The following sections will cover connecting your FastRIP dongle to your computer as well as 
your printer.

Dongle Connection

Your USB port Dongles require specific steps to be followed when connecting to your computer. 
Please read the installation instructions completely before connecting the Dongle.

NOTE: If you were using a Parallel Port Dongle, you MUST upgrade to a USB dongle. If you do not have a  
        USB dongle, please contact technical support. 

IMPORTANT POINT If you are using the Blue-colored USB Dongle, 
DO NOT plug in the Dongle until AFTER you are finished with the software 
installation. If the Dongle is inserted into a USB port prior to installing 
the FastRIP software, Windows may install the wrong driver. It is safe 
to insert the USB Dongle into a USB port while your computer is 
running. 
 
If your package included either a Kingston or Orange-colored 
dongle, CONNECT IT NOW. Windows will automatically 
detect the device. You can then click Next to continue. 
 
If your package included a Blue-colored dongle, then connect 
it as outlined at the end of the product installation.
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Connecting  Your Printer to Your Computer

You may only connect the T-Jet printer to a computer 
using a USB 2.0 cable. For best results, use the special 
gold tipped USB cable supplied with your T-Jet. Avoid 
using a cable that is over 6ft in length and do not use a 
switch box or USB Hub. Failure to follow the guidelines 
can cause communication problems between the printer 
and your PC. Do not overload your USB ports. Reserve 
one for the printer, one for the dongle (FastARTIST/
FastRIP) and one for your mouse (if necessary).

A USB Port is much smaller than a Parallel Port. The cord has a small rectangle with a “lip” 
inside one end and the other end is a hexigon-type shape that plugs into the printer. There are 
often USB Ports on both the front and back of a computer. It is recommended that you connect 
your USB cable to one of the back ports to prevent damage to the connector through accidental 
contact. To connect your printer to your computer via USB cable, most standard USB to Parallel 
or USB to USB cables will work.

The Universal Serial Bus (USB)  method of communication 
is standard on all newer computers, but a little known fact is that 
only a certain amount of power is supplied to the entire “bus.” If 
you have several items (other than a mouse and the FastARTIST 
Dongle) plugged into different USB ports on your computer, this 
may cause communication issues with the printer.

NOTE: We recommend using a dedicated computer to control your T-Jet printer. Avoid using extra USB 
ports for items such as a webcam, joystick, additional printer etc.

 

Your printer User’s Manual details connecting your printer through the USB port. Refer to 
Chapter 3 SETUP PART 3 - Interacting with the Blazer Express or Chapter 4 SETUP PART 

3 - Interacting with the Blazer PRO, depending on your model.
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Installing the Printer Driver
Although FastRIP has its own printer drivers, you must install the printer driver that came with 
your printer in order to utilize utility programs like Head Cleaning and Nozzle Checks. These 
are only available for use through your standard inkjet printer driver. If your printer driver has 
already been installed, skip this section of installation and continue on with Installing FastRIP.

DO NOT install the EPSON Stylus RIP Postscript driver. This driver can confuse the FastRIP 
installation. If you have already installed this driver, delete the Postscript Epson printer driver 
and re-install only the standard driver. You can ensure you have the most current inkjet driver by 
going to www.epson.com and downloading the most recent version.

After FastRIP, is installed you will have TWO EPSON drivers - the normal driver and one that 
FastRIP uses.

Load the “Epson Drivers” CD that came with your printer, into the CD drive.1.	

Save any work and close any other programs that may be running on ``
your computer at this time, such as Word, Photoshop etc.

Insert the Driver CD into your CD drive and follow the on-screen ``
prompts.

NOTE: Install the regular Epson driver for your inkjet printer, but NOT the optional Epson Stylus Pro RIP. You  
        need the normal driver for performing Head Cleaning Utilities and other utilities.

For more information, refer to your Inkjet-to-Garment Printer’s User’s Manual.

2.	 Turn your printer ON. 
 
A message balloon may appear in the bottom 
right hand corner of your computer screen stating 
“New hardware found.” After a few moments, 
another balloon may appear with your printer’s 
make and model listed in it. Your computer 
should now recognize your printer. 
 
You can also check by clicking on Start > Settings 
> Printer and Faxes. An icon representing your 
printer should now appear in the Printers and 
Faxes window that just opened. 

You must now configure FastRIP to work with your printer.3.	

Go to `` Start > Programs > FastRIP 10.0 and click on FastRIP.

Select your Epson printer and click on `` Next. 
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On the next screen, select the option “Search for new printer package ver-``
sions from CD.”

Place a check mark by “Search CD-ROM or floppy drive.”``

Click on `` Next. Click on Next.

Click on `` Finish.

Next you need to set the default printer your software will use.4.	

In the FastRIP main window, go to `` Printers > Manage Printers.

Place a check in the Control Panel box next to your Epson printer and ``
click on Ok. 
 
FastRIP is now ready to use. Refer to the following section, Installing 
FastRIP Software, for further instructions.

Register your company in the FastRIP User’s Arena at 5.	 www.screenprinters.net.  
 

Installing FastRIP Software
At this point, you have confirmed that your FastRIP package contains both the installation CD 
and Dongle security device. The following steps are an overview of installing FastRIP. Within the 
installation wizard, further information is provided with each individual stage of the wizard.

The FastRIP installation process will install both FastRIP and printer support files. During the 
installation of FastRIP, there should be no other applications running. Many antivirus software 
programs can also interfere with the installation, so it is recommended you also disable any anti-
virus software until the FastRIP installation process is complete.

The FastRIP CD
In addition to FastRIP, the FastRIP CD contains a 20 day trial version of FastFILMS, a complete 
catalog of FastART, a catalog of effects available with FastFX, sample files and Adobe Acrobat 
Reader.

Beginning the Installation

1.	 Connect the USB security device NOW.
Insert the FastRIP CD into your CD drive. The installation program should start automatically. 
 
If the FastRIP installation does not start 
automatically, follow these steps.
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Click on `` Start > Run and then the Browse button.

Find the drive that contains your CD and select the folder named `` Install.

Open this folder and `` double-click on the file named Setup.exe. 

IMPORTANT POINT If your package included either a 
Kingston or Orange-colored dongle, CONNECT IT NOW if 
you haven’t already. Windows will automatically detect the 
device. You can then click Next to continue. 
 
 
 
 

If your package included a Blue-colored dongle, then connect it as 
outlined at the end of the FastRIP Software installation. 
 

Choosing a Language

The installation process will begin by querying your language 
preference. Choose the desired language and click OK.

Installation Wizard

After selecting your language preference, 
the installation process will begin. When 
the install pauses at “Welcome to the 
InstallShield Wizard,” click Next. 
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Licensing Agreement

Read the Licensing Agreement thoroughly 
prior to accepting the terms and condi-
tions. Clicking Next implies acceptance of 
the agreement.

 
 

Choosing an Install Destination

Select the destination folder for FastRIP. 
This will be the central location where 
executable and workspace files will be kept. 
It is strongly recommended you do not 
change the default destination folder! If 
you are running any other devices that use 
Dongles or similar RIP technology, there 
might be Dongle or RIP conflicts if this 
destination is changed. When ready, click 
on the Next button.

Select a Program Folder

Choose a program folder location where 
FastRIP shortcuts will be placed. These 
shortcuts will become accessible through 
the Windows Start menu. This creates the 
program directory FastRIP 10.0 on the 
start menu.

Scanning for Resources

The installation program will scan the computer for available resources. It may take several mo-
ments for the installation to resume. You will then see the installation progress window. 
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Concluding the Installation

Once the installation is complete, FastRIP will ask if you want to re-boot your computer. Refer 
to the following sections that referring to your particular dongle type to conclude the install.

Parallel Dongle Installation

If you will be using the `` Parallel 
Port Dongle, select “No, I will re-
start my computer later” and click 
Finish.

Manually shut down your comput-``
er and turn OFF your printer. 

Insert the Parallel Port Dongle. ``

After inserting your Dongle, turn ``
ON the power to your printer and 
then reboot the computer.

USB Dongle Installation

If you will be using the `` USB Dongle, select “Yes, I want to restart my 
computer now” from the on-screen menu.

 Click Finish. FastRIP will shut down the computer and automatically ``
reboot it.

Once the computer has rebooted and the Windows desktop has returned, ``
insert your USB Dongle. 

IMPORTANT POINT 
In the event you have a bad Dongle or the Dongle driver was not installed correctly, a window will 
pop-up stating, “Dongle Error, Dongle not found or valid.” This means the Dongle was not recog-
nized by the computer. Verify that the Dongle’s serial number matches the serial number from the 
Product.icf file.
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Un-installing FastRIP
Should you need to un-install FastRIP 
from your computer, click on Start > Con-
trol Panel and locate the icon labeled Add 
or Remove Programs. Double-click on this 
icon and another window will open. Scroll 
through the listings until you see FastRIP. 
Click on the program to highlight and 
then click on the Remove button. In the 
FastRIP Setup window select Remove and 
click on Next.

The un-install process will remove most of the program components, however a folder MUST 
still be deleted from your hard drive. Right-click and Explore your My Computer icon on your 
desktop. Double-click on your C:\ drive and double-click on the folder labelled Program Files. 
Right-click on the FastRIP folder and select Delete. Delete the RIP driver by going into Start > 
Settings > Printers and Faxes. Right-click on Epson Color Stylus *, Epson Photo Stylus *, or Epson 
Stylus Pro * Full/Sheet and select Delete.

Re-installing FastRIP
If you are going to re-install the program you DO NOT need to un-install first.

Simply place the CD back in the computer and allow it to run through a ``
normal installation.

Click on `` Yes when asked if you wish to install over the existing version of 
FastRIP.

Click on `` Ok when asked if it’s Ok to share the folder.

Restart your computer.``

NOTE: Whether you are using a USB or Parallel Dongle on the PC, you will not need to remove the Dongle 
during a re-installation of the software. Your computer already knows to recognize the Dongle from the previous  

          installation.
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Setting Up FastRIP
Configuring Your Printer

After you have completed the basic installation, FastRIP is ready to run. However, prior to print-
ing a job from a graphics program, you must configure FastRIP to work with your printer.

1. First Time Setup Dialog

The First Time Setup screen will 
appear letting you select your pre-
ferred measurements options.

2. Printer Driver Selection

1.	 Go to Start > Programs > FastRIP 10.0 and click on FastRIP. 

A screen will prompt you to select a 2.	
printer.

Highlight the printer drivers you ``
wish to install and click on the Next 
button. You will only see the printers 
listed that work with the version of 
FastRIP you have purchased. 
 

NOTE: You may return to this screen at a later time to add additional printers.
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3.	 From the next screen, select the option “Search for new printer package versions 
from CD.” Place a check mark by “Search CD-ROM or floppy drive.” 

Click on Next. Click on Next. Click on Finish. When the “Configuration 
Complete” window appears, click on Next. 

3. Create Queue Wizard Intro

The next steps in the installation process will 
be completing the Create Queue Wizard. 
The Introduction window will open automati-
cally. 

Click Next and follow the steps below.

4. Select a Printer Queue

The Printer Defaults window will now ap-
pear. This wizard will walk you through the 
process of configuring your printer port and 
other default printer options.

Select your printer and its output port.1.	

The T-Jet only supports USB con-``
nections. 
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Select a USB port from the Port drop-down list, if not selected already.``

Click the ellipsis (...) button to the right of the Port drop-down list to ``
open the Print Mode Selection dialog.  

2.	 A Port Setting window will open reading “Properties 
for port:LPT1: 
 
An LPT Port (also known as a parallel port) is the 
most commonly-used printer port. 
 
LPT Mode, also known as “Printer Port mode,” 
determines the transmission rate of data sent to the 
printer. Although faster rates of transmitting data 
are preferable, the printer must be capable of 
sustaining the selected mode. 
 
Faster data rates also increase the chances of trans-
mission errors, so using a good quality IEEE 1284 
cable is important.

For the initial installation, leave the port’s Properties settings at the `` De-
fault. If “gaps and lines” start to appear in the output, the LPT mode may 
have been set too high, preventing the printer from receiving data consis-
tently. Should you need to change the LPT Mode, the following section 
briefly describes the available modes.

5. Set LPT Parameter (Optional)
The following is a list of LPT settings that can change how your computer sends the data 
through FastRIP and to the printer. We recommend leaving the settings in the Port Settings Dia-
log as default, however, they can be adjusted for certain needs or concerns. These settings can be 
accessed in the Port Settings > Advanced screen.

LPT Mode SPP, Normal, or Compatible``  
These modes are synonymous and refer to the same setting. In this mode, 
data from the computer to the printer is transmitted at the slowest rate 
possible. In this mode there are very few errors however, printing time 
will also be at its longest. If your printer can not operate without errors in 
any of the faster modes, you will have to use this mode.

LPT Mode EPP ``  
This is the mid-range speed setting. It is not often used, but may be a 
good compromise between ECP and SPP modes.

LPT Mode ECP``   
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In this mode, data is sent to the printer at the fastest possible rate. Gener-
ally most printers can support this speed, but if your prints show errors, 
your printer may not be capable of this mode.

Automatic``  
If the Automatic option is enabled, FastRIP Queue will attempt to de-
termine the fastest possible mode for sending data to the printer. FastRIP 
Queue will test for ECP (fastest rate) capability first, followed by EPP 
(mid-range rate), and then SPP (slowest rate). 

LPT 2 or LPT 3``  
If your printer is connected to LPT 2 or LPT 3 choose the Windows LPT 
Driver. 

Note: A specific data rate may be  “forced” for a specific job by disabling the Automatic option. When you start a  
        new job, FastRIP will automatically perform its checks again prior to delivering the new output.

 

6. Set Timeout Options

While still in the Port Settings Window, select the 
Timouts Tab. The Timeouts Tab allows you to tell 
FastRIP what to do in the event of “Time Out” 
error. This error most often occurs when printing 
a large file and is the result of an interrupted data 
stream.

Set the Retries to 999 and the Initial to 60. ``

7. Print A Test Page

It is recommended that you print a test page to make 
sure that your computer is properly communicating 
with your printer. For more Test Page printing op-
tions, refer to Chapter 10 - FastRIP Print Options 
-Printing a Test Page.

To do this, click on 1.	 Start > Settings > Printers 
and Faxes. 

In the window the pops up, find your Epson 2.	
Printer and right-click on it.

Under the 3.	 Properties tab, click on the button labeled “Print a Test Page.” 

If the test page does not print, or does not print correctly, refer to the following step in looking 
up your connection type and for instructions on settings/ports.
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8. Set the Connection Parameters

If your printer completed a positive test print, skip this step and continue with Step 9.

The following sections will cover setting the parameters to correct or initially setup your connec-
tion properly. Refer to your particular connection to learn about the needed settings and adjust-
ments necessary.

USB Parameters

Most printers that support USB connections are known as “Plug and Play.” This terminology 
means that after the printer drivers have been installed, Windows will automatically recognize 
your printer and to which USB port it’s connected. 

 
 

9. Layout Mode

The Layout Mode window lets you select how 
to handle jobs as they are imported.

When finished, click Next.
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10. Media Setup

The Media Setup window allows you to con-
trol the default setting of media used and size 
of media.

When finished, click Next.

 

11. Name Your Production Queue

The Name Your Production Queue window 
lets you assign any given name to the Queue 
you just created.

Click Next, when finished.

 

12. Output Options

The last window in the Creat Queue Wizard 
is the Output Options window. This lets you   
set the default printing options for jobs that 
have been sent to the RIP Queue for printing.

When finished, click Finish.



23
Version 1.2    Revised  March, 2009

Chapter 3 - Setting Up FastRIP 

13. Add Printer to Queue Window

The FastRIP Pro-
gram Screen or 
“Queue”- win-
dow should have 
opened. This is the 
same window you 
will see when the 
image processor 
is working. There 
are a lot of options 
that can be accessed 
from this screen, 
but for now, are 
only concerned 
with the Manage 
Printers screen. 

From the 1.	 Printers Pull-down Menu, select Manage Printers. 
This window will list all printers connected to your computer.

Locate your Epson printer and place a check in the Control Panel column. Click 2.	
on Ok. This will add the printer to the Printers Window.

NOTE FOR EPSON 7600 AND 9600: With FastRIP XL and FastRIP LF, you will see listings for Epson Stylus 
Pro * Full and Epson Stylus Pro * Sheet. The “Full” is for roll film and the “Sheet” is for sheet fed film. You should 
check both drivers.
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Two EPSON Drivers....
When you choose the Epson printer driver during installation, FastRIP creates a new “Postscript” 
driver for the printer. The new driver is actually a FastRIP tool that tells FastRIP to rasterize the 
image before sending it to the printer. This new driver is called Epson Stylus Pro 4000 PS, Epson 
Stylus Pro 4800 PS, Epson Stylus Pro 7800 (FastRIP XL) or Epson Stylus Pro 9800 (FastRIP 
LF). The standard Epson driver is called EPSON Stylus Photo *, EPSON Stylus Pro *, or EP-
SON Stylus Color *. These ARE NOT the same drivers. It is very important to remember which 
driver to use with FastRIP.

Also, the FastRIP High Speed Driver will look like Epson 4800 Separations.

To see the various printer drivers on your system, go to the Start Button on the Windows Task-
bar. Click on Settings > Printers or Control Panel > Printers and Faxes and you will see this win-
dow.

IMPORTANT POINT
If you right click on the “new” FastRIP print driver and select Properties, you will notice 
under the Port tab in Printer Properties that this “driver” prints to a port called FastRIP 
Demo 9.0: My Queue (PhotoScript Port), and NOT your standard LPT*, USB, FireWire, 
or Ethernet port.

Printer Updates
Getting the latest updates for your printer

To obtain the latest print modes for your printer:

1)	 Ensure your Internet connection is active.

2)	 From the Printers menu, choose 
Manage Printers. The Manage Print-
ers dialog will open.

3)	 Click the printer name that will be 
checked.

4)	 Click the Check for online updates button. If updated print modes are avail-
able, then the Update printers button will become available. 

5)	 Click the Update printers button to update the print modes.
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Port Selection
Output Port

1)	 From the Printers menu, choose Manage Printers.

2)	 The Manage Printers dialog will open.

3)	 For the given printer, the Port column indicates the output port.

4)	 To change the port, choose a port from the drop-list.

5)	 To change the port settings, click the ellipsis button (three dots) that is to the 
right of the drop-list.

Of the various port settings described in the following sections, the USB Port is recommended 
for output from FastRIP. Other port methods are described in the electronic help file.

USB Port

This is the recommended output port to use with FastRIP.

A Universal Serial Bus (USB) port has the benefit of allowing new hardware to be added without 
configuration concerns or hardware conflicts. In addition, a USB device may be added without 
requiring the workstation to be restarted.

1.	 When the Epson printer is connected to the computer via its USB port, Win-
dows will automatically detect the USB printer.

2.	 In FastRIP, the USB port name for this printer should now be available.

3.	 From the Printers menu,  choose Manage Printers.

4.	 The Manage Printers dialog will open.

5.	 From the Port column drop-list, choose the USB port that is named specifi-
cally for your Epson model. Example: For the Epson 4800, the USB port will 
be listed as “EpsonStylus Pro 4800_USB00X+port name.”

Note: Depending upon advanced settings within FastRIP, it is possible that there is a secondary “USB00X” port  
         (or “LPTUSB1” in the case of Belkin Adapters) that is available. Do not choose either of these secondary ports,  
        unless requested to do so by Tech Support.
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Printer Sharing on Windows 2000 and XP

Setting up the Host Computer

On a Host Windows 2000 computer, setting up printer sharing is done through the Sharing tab 
of the printer driver properties. The procedure for Windows XP is similar.

1.	 From the Start menu, Settings, choose Printers.  

2.	 The Printer dialog will open. Right-click the icon of the printer to be shared. A 
context menu will appear. 

3.	 From the context menu, choose the Properties option. 
The Properties dialog for the printer will open. 

Select the Sharing tab.4.	

On the Sharing tab, choose Shared and enter a name 5.	
for the printer in the field.

Click OK to accept the new settings. 6.	
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Setting up the Remote Computer

Assuming that the Host Windows 2000 computer has been set up to share its connected printer 
over the network, Remote Windows 2000 computers may use the following procedure to add 
that printer as a resource. The procedure for Windows XP is similar.

1.	 From the Start menu, Settings, choose Printers.

The Printers dialog will open.2.	

Double-click the Add Printer icon. The Add Printer Wizard will launch.3.	

Click Next. The location of the printer must now be selected. 4.	

Choose Network printer, and click Next.5.	

Windows 2000 will now compile a list of the printers that are available on the 6.	
network.

Choose the printer that is connected to the Host computer, and then click Next 7.	
to complete the Add Printer sequence.
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Toolbars and Menus
 

Overview of FastRIP Interface
The following sections will cover the Main Window elements of FastRIP 10.0 such as the Pull-
down Menus and Toolbar buttons. For further information on these tools and settings, refer to 
the following chapters.

 The main elements of the FastRIP window are:

Jobs in the Active List are positioned in the Preview Pane. Selecting a job 
provides additional controls for modifying its layout. 
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The Pull-down Menu Bar

The Pull-down Menus, also referred to as drop-down menus, provide the main FastRIP controls.

The `` Queue menu provides controls for adjusting FastRIP parameters.

The `` Jobs menu provides controls for adjusting selected print jobs.

The `` Printers menu provides management for printers.

The `` Tools menu provides access to advanced RIP settings.

Queue Pull-down Menu

When print jobs are received by FastRIP, they are added to the queue of active jobs. The Queue 
menu contains basic controls for starting, stopping, and scheduling of print jobs.

Manage Queues``  – Create a queue, or change the port or printer of an 
existing queue.

Start``  – Process jobs as they are received in queue. Scheduling settings ap-
ply to received jobs.

Stop``  – Hold all jobs in queue, regardless of Scheduling settings.

Clear Job Errors``  – Reset any errors that were reported, such as paper out.

Properties``  – Open the Queue Properties dialog.

Jobs Pull-down Menu

The Jobs menu contains controls for printing, previewing and deleting print jobs.

Restore jobs``  – Manage archived print jobs.

Select all``  – Selects all jobs in queue.

Select none``  – Clear current selection.

Remove``  – Delete the selected job.
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Rename``  – change the job name.

Open Page``  – discard the spool data, such that individual jobs can be 
scaled, rotated, etc.

Locate Job``  – find the job in the Preview Pane

Release``  – release a held job

Hold``  – stop the job, regardless of whether queue is stopped

Abort``  – cancel the print job

Clear error``  – reset any errors that were reported, such as paper out

Add to Layout``  – move an unscheduled job into the active list, and show 
in Preview Pane

Print``  – send job to the printer

RIP Only (Preview)``  – spool the print data without sending to printer. 
Once spooled, the print data can be previewed

Generate Preview Image``  – if thumbnails have been turned off, then cre-
ate a preview

Properties``  – open the Job Properties dialog

Show log console``  – when printing a job, open a log window. Same as 
Jobs menu >> Properties >> Log tab

Printers Pull-down Menu

The Printers menu contains controls for managing printers, print modes, and page sizes.

Manage Printers``  – Open the Manage Printers dialog, which is used to 
add support files for new printers, and check for support file updates.

Manage Print Modes``  – Copy and edit print modes for a given printer.

Manage Print Media `` – Define media dimensions in terms of sheets, 
rolls, and templates.

Printer Properties `` – List printer settings.

Print Test Page `` – Choose target charts for testing the printer output.
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Tools Pull-down Menu

From the Tools Pull-down menu, choose Options to open the Options dialog. The available 
tabs are as follows:

General``  – Basic controls for customizing the FastRIP interface.

Queue Base Folder `` – The location of Queue production files.

RIP``  – Allocate memory for the RIP, and set the relative priority of jobs 
with respect to other Windows applications.

Processing``  – Spool extra jobs whilst waiting for the current print job to 
finish.

Preview Options``  – Adjust the thumbnail image that is displayed next to 
each job name in the queue.

Main Toolbar

The Main Toolbar, just below the Pull-down Menus, provide basic (Start / Stop) controls.

Below is the list, from left to right, of the 10 buttons in the Toolbar and what they do.

Open:``  This is the first icon in the list. The Open Icon lets you import a 
new job into the Queue list (shortcut of File>Import).

Remove:``  By pressing the Remove button, all of the jobs that are currently 
selected (highlighted) in the Queue Window or Archived window will be 
removed. You cannot undo a remove command.

Release Job:``

Hold Job:``

Clear Errors:``

Abort Job:``  Lets you cancel a job from spooling or printing.

Start Queue:``  By clicking the Start Queue button, all jobs will be pro-
cessed according to the scheduling settings within the queue properties.

Stop Queue:``  The Stop Queue button will cause all jobs to be held, regard-
less of the scheduling settings within the queue properties
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Configure Queue:``  Lets you setup and configure queue settings to a job 
that is currently in the queue list (shortcut for Queue>Properties Pull-
down Menu selection).

Printer Status and Settings:``  This button will allow you to adjust printer 
settings and to view the current status of the printer. 

NOTE: The Toolbar Icons that are grayed out, are not currently available with the current selection or situation.

Queue Tabs

Select between printers using the 
Queue Tabs located below the Main 
Toolbar. Each tab will display the 
printer title that is associated with it 
and the number of current/holding 
jobs located in it’s Active List.

Active List

In this section of the RIP Window you can view each job that has been imported into FastRIP 
and control its current status or settings. If you wanted to adjust an imported job or cancel a 
function, highlight the job in the Active List, then select either a function from the main Toolbar 
or right click on the job for other options. Jobs can be dragged here for storage or dragged back 
to the Active List for printing.

At the top of the Active List is a section title showing particular information about the job; 
everything from the Job Name to the Job Cost is listed here. By right-clicking on any of these 
titles, you can specify which ones or present. In this example all options are present. Each line 
between the titles can be dragged to expand the information under that title. The scroll bar at the 
bottom of the window lets you view the information of the job when expanded.
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Unscheduled or Archived Jobs

After a job has been printed, it will show up in the Unscheduled or Archived Jobs area of the RIP 
Window.

Preview Pane

Here you will see the placement of the job to be printed or printed job in relation to the page 
layout or template that have loaded for that job. 
 
Located in the Preview 
Pane is a Zoom tool 
that lets you zoom in 
and out of the page 
layout. It also features 
page control arrows 
and scroll bar as well 
as a ruler specifying 
the art in relation to 
the unit measurements 
selected.

Job Settings

Here you can specify (adjust) the size and position of your artwork in relation to the page. You 
can also adjust the page layout and template specifications as well.
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Program Settings
General Interface Settings

From the Tools Pull-down Menu, choose Options and then click the General tab.

The General tab provides basic controls for customizing the FastRIP Window:
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Show splash screen

When launching the FastRIP Window, this checkbox controls whether the FastRIP Window 
splash screen will be displayed.

Always on top

If this checkbox is ticked (ON), then the FastRIP Window window will always remain in the 
foreground “above” other windows.

Show advanced settings

Tick this checkbox (ON) to enable advanced control tabs in both the Queue Properties dialog, 
and Job Ticket Properties dialog.

Automatically track items

If this checkbox is ticked (ON), then selecting a job in the active list or archive list will display 
details about that job in the Media Settings pane. When OFF, it is necessary to select a job in the 
Preview Pane in order to display such details.

Process multiple page jobs as overlay

When this checkbox is ticked (ON), received jobs that contains multiple pages will be automati-
cally placed above each other in the Preview Pane.

Select pages when importing multiple page job

Choose pages when importing a multiple page job. For example, if a multiple page PDF docu-
ment is received, then the Page Manager will provide options for previewing and selecting which 
pages to import.

Set display unit

Choose the unit of measurement that will be used throughout the FastRIP Window.

Set decimal places

Choose the precision of measurements used in FastRIP Window.

Reset hidden dialogs

The FastRIP Window uses warning dialogs to confirm whether a given action should proceed. 
Such warning dialogs have a checkbox that can be checked to prevent that warning dialog from 
reoccurring. However, if there is a new user that is learning how to use the FastRIP Window, 
then click the Reset All button to force all dialogs to be shown again. Alternatively, click Ad-
vanced to select which warning dialogs to show.
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RIP System Settings
From the Tools menu, choose Options and then click the RIP tab.

The RIP Settings are used to specify the resources that are available for spooling (rasterizing or 
RIP’ing) print jobs. These controls will directly influence the workstation that is performing the 
RIP calculations. 

RIP System Location

The RIP System Folder field explicitly states the directory to which the FastRIP Window RIP 
has been installed. This information is provided to help CADlink Tech Support diagnose issues 
quickly.
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RIP Memory Allocation

Memory refers to the maximum amount of workstation memory (RAM) that may be used by the 
queue when creating a spool file. If more than this limit is required, then Virtual Memory (VM) 
will be used. Virtual Memory refers to hard drive space that is used to supplement RAM. Virtual 
Memory is used to effectively provide applications with more RAM than the workstation has 
installed. However, accessing hard drive space is much slower than real memory.

RIP Priority Level

All software processes have a Priority Level that determines how the workstation processing time 
is shared amongst the processes (different software applications). Normally, processes are assigned 
equal priority levels by default, but modifying the priority of individual processes is acceptable 
where this improves overall workstation performance.

If the RIP Priority Level is increased, then print jobs will be processed faster, though this will be 
to the detriment of all other software processes that are running on the workstation. Other pro-
cesses will simply require more time in order to complete their operations.

Conversely, if the RIP Priority Level is decreased, then print jobs will require more time to com-
plete.

Processing Settings
From the Tools menu, choose Options and then click the Processing tab.

Concurrent RIP Operations

Though the queue can spool a print job quickly, there is still time required to send the spool data 
to the printer (say over a network). In addition, the printer has a physical limit with respect to 
how quickly ink can be laid upon the media.

Instead of waiting idle for a spool file to be completely received by the printer, the queue can 
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begin creating spool files for subsequent print jobs concurrently. However, please note that only 
one spool file is being compiled at any given time. The Maximum number of concurrent RIPs 
limits the number of spool files that can be compiled in advance of the job that is currently being 
spooled.

 
 
 
Preview Options

From the Tools menu, choose Options and then click the Preview Options tab.

By default, when a new job is received by the FastRIP Window, its name is listed in the Active 
List of jobs, a thumbnail image of the job is shown next to its name, and a thumbnail preview of 
the job is shown in the Preview Pane. Typically, these thumbnail previews are of medium quality, 
though the preview quality can be increased using the Preview Options.
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Generate thumbnail previews

Clearing this checkbox (OFF) will prevent thumbnail previews from being automatically created. 
However, previews can be manually created by right-clicking the given job and choosing Jobs 
menu >> Generate Preview Image.

Preview quality

Adjusts the screen resolution of the generated preview. Higher quality will require the greatest 
amount of time in generating the preview.

Gamma adjustment

Adjusts the relative brightness of the generated preview.

Preview image bits per pixel

Limits the number of color shades that can be assigned to a given pixel. Choosing 1 bit per pixel 
will create preview colors that appear blotchy.

Limit number of previews

By default, when multiple jobs are received at the same time, thumbnail previews will be me-
thodically generated one-by-one. Use the slider to increase the number of previews that are 
generated in parallel.

Advanced RIP Settings

Performance

From the Queue menu, choose Properties and click the Performance tab.

For most cases, the Resolution Reduction slider should be OFF. The Resolution Reduction 
slider is used to reduce the resolution of the data being spooled, thereby reducing the size of the 
required spool data. For text and line art, it is likely that half of the resolution data can be dis-
carded without impacting the appearance of the printed output.

However, avoid reducing the resolution with images (i.e., gradients that utilize halftones), since 
the quality can deteriorate quickly.

If the Intelligent Resolution Reduction checkbox is ticked, then the Resolution Reduction 
feature will be applied automatically using a sophisticated set of criteria.
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Page Layout
Page Layout/Media Setup

The following sections will cover setting up your page layout, creating custom page sizes and 
other page options available with FastRIP 10.0.

Setting the Page Size

Queue Pull-down Menu>> Properties>>Media Setup tab 

The page size is the size and margins of the loaded media, which will be used for positioning of 
jobs in the Preview Pane. The page size is set as follows:

1)	 From the Queue Pull-down menu, choose Properties.

2)	 On the Media Setup tab, set the Type of media.

Roll media `` - Preview jobs according to a specific roll width.

Fixed sheet media `` - Preview jobs in terms of the sheet width and 
height.

Automatic sheet media `` - Use the sheet width and height that was 
defined in the design application. 

3) From the Name drop-list, choose a preset media. 
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About Custom Page Sizes

If a custom page size is being created, then the dimensions of the page size must correspond to 
how the page will be rendered on the printed page.

For example, if a tall document is being printed with portrait orientation, then the dimensions of 
the custom page size will be the same as the image dimensions. 

However, if a landscape orientation is being used, the document will be rotated through 90 de-
grees, and the custom page size dimensions will be reversed. 

This is summarized in the following table: 

ORIENTATION	     CUSTOM PAGE HEIGHT       CUSTOM PAGE WIDTH 
	 Portrait			  Document height		     Document width 
     Landscape		  Document width		     Document height 

Creating a Custom Page Size

Queue Pull-down Menu>> Manage Queues 

In the following procedure, the Printer Page Setup dialog is used to create page sizes that can be 
selected in your design application.

1)	 Choose Queue Pull-
down menu >> 
Manage Queues.

2)	 For the given printer, 
under the Control 
Panel column, click 
the Install button.

3)	 Click Close to close 
the Manage Printers 
dialog.

4)	 Next, from the Tools Pull 
down menu, select Options.

5)	 On the General tab, set the 
display units in which page 
sizes will be defined.
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6)	 Click OK to close the 
Options dialog.

7)	 Select, from the Printers Pull-down 
Menu, Manage Print Media.

8)	 From the Show media for drop-list, 
choose the printer name.

9)	 The existing page sizes for the printer 
will be listed.

10)	Click the Add new print media but-
ton.

11)	From the Create New Media dialog, 
choose either Roll or Sheet.

12)	Complete the parameters for the 
given media.

Working with Page Layout Templates
Templates can be used for lots of different work flows and you can use multiple templates within 
a queue. Templates will save you hours of time and allow you to automated repetitive tasks such 
as laying out jobs as well as setup an automated work flow inside FastRIP if required. When us-
ing templates, jobs as they arrive can be automatically scaled, rotated and positioned. 

NOTE: The templates are most useful when printing on garments with a T-Jet Inkjet-to Garment Printer.

Some of the uses for templates are:

Setting up a custom board size, where you can select the size of the print ``
area and its exact position inside the print area of the bed

Setting up custom nesting of jobs, multiple board / print areas inside the ``
print area of the bed (for example on the Blazer Pro setup 3 different shirt 
boards).

Automatic duplication for print the same image on a number of golf balls ``
or hat at the same time.
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Selecting a Template

Queue Pull-down Menu>> Properties>>Media Setup tab

To use templates, you must first make sure you have your Queue properties - Media setup con-
figured for Templates.

Under the 1.	 Type 
drop-down arrow, 
select Template 
Media.

To select a existing 2.	
template, under 
Name drop-down 
arrow, select one 
from a list. 
 
 

NOTE: To select a template from another location (a custom template in a custom location) click the  icon  
        to browse for the custom template. See next section, Creating a Custom Template.

Creating a Custom Template

Select Add New Media 1.	
 
There are 2 ways to select Add New 
Media.

`` Select Add New Media from the 
Template list in the Media setup. 
 
 

`` Select Add New Media from 
the main window in the 
smart menu area (with no 
job selected) you can select 
Add New Media from the 
Template Media options 
drop down selection.
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2.	 Set Name and Page Size 
 
The Template Setup Dialog will open.

First, enter in a name for the ``
template under Name. For 
this example, we’ll be setting 
up a 3-up Shirt Board tem-
plate for the Blazer PRO

Next, select the total page ``
size under Based on Sheet. 
For this example, 17x45 
inches is the total printing area of the machine. 

NOTE: You can enter in a custom size by selecting Custom from the list.  Enter the dimensions under Size.

3.	 The next step is to define the first slot. 
Slots are somewhat like nesting where you set the printable areas and later assign 
the images to those areas for printing. For this example, the slots will represent the 
Shirt Boards on the Blazer Pro. Jobs are printed inside of the slots and areas 
outside of the slots are the non-printable areas or masked areas. You can have 
multiple slots in several different arrangements to accommodate any need, if 
required. Each slot will have a number assigned to them (from 1 to 9). Slots 
assigned with a unique number 
can be for separate jobs or slots 
that share the same slot number 
will print the same job.

To define the first slot, under ``
Slot Label, select 1 (use 
the up and down arrows to 
adjust.

Next, the `` Position fields act 
as margins. For this example 
we will set the left and right 
margins to 0.5 inches and 
the top and bottom to 1 
inch.

Under `` Size, enter in the 
print area dimensions. (16” 
wide and 13” high for this 
example).
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Under `` Alignment, set at center for the job to be automatically centered 
in the slot. 

You can set `` Automatic Scaling to enable jobs to 
be scaled and positioned after they are added to the template. This feature 
can help to ensure that the job is the right size before printing. For this 
example we are leaving it as is. 

`` Under Rotate, you can select to have the 
template automatically rotate the artwork based 
on landscape/portrait settings. For this example, 
we have selected Rotate 270 (90° x 3 clockwise) 
based on having the shirt loaded with the neck 
of the shirt on the left of the slot (shirt board). 
If you wanted to load the shirts on the right 
side, you would select Rotate 90.  
 

`` Once you have added all the details for your slot, click on Add to create 
and it will show in the preview. 

ORIGINAL ROTATED 
270° (clockwise)
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Add Additional Slots (if necessary). 4.	
Additional slots can be created by repeating step 3. Deselect current slot and 
continue with the next dimensions. If the next slot overlaps the current slot, it will 
not let you add. 
 
If the next slots will be the same (dimensions etc), you can easily make duplicates 
of the first slot or any other slot. 
 
There are five icon tools that will help in the creation of your template layout.  
 

Copy selected slot down in position  
Copy selected slot to the right  
Delete selected slot  
Move selected slot up  
Move selected slot down 
 

 
The Copy slot spacing will allow you to adjust the 
measurement between the copied slots (either by left 
and right or by above and below). The measurements 
here must be entered prior to selecting a copy func-
tion in order for the entry to work properly. 
 
So, if you wanted extra space between the first slot and the one that will go below 
it, do the following:

 Select the slot to copy``

Enter the extra measurement in the appropriate field``

Click `` Copy selected slot down in position.

NOTE: If an icon is grayed out, it is not available for use, i.e., not having enough room on the template available.
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5.	 Separate slot numbers (if necessary). 

Copying slots will leave all the slots with the same slot number (1). This is fine if 
you are for printing copies of the same job.  If you want to print different designs 
on each slot, change the slot numbers of the duplicate slots.

Select the slot you want to change``

Adjust the slot label number to a new number.``

Click `` Update to apply the change 
 
Any other changes you want to make can be made in the same way.  

Click Save to save your new template. 6.	

Note: You can create as many different templates as you want and select them from the main interface as 
discussed in the earlier section, Selecting a Template.
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Template Settings

Import Template Job Dialog

In the Layout Manager you can 
choose how jobs are added to the 
templates.

By default the “Show import template job” dialog is 
enabled. This means as each job is added to FastRIP a 
dialog will display which template and slot are used, 
allowing you to edit the setting.  If this is disabled 
then the Express method is used.

Express will import the job into the next ``
available slot, using the currently selected 
template in the queue.

Select will allow you to select which template ``
and slot you want to add this job to. 
 
Select the template you want to use from the 
drop list. 
 
Select the slot you want to use by using either drop down list on clicking 
on a slot.

Cancel will cancel and the job will not be added.``
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Layout Adjustments and Options

Once jobs are added you can change there position and re-size them as normal, you can even 
drag and drop jobs between slots if required.

Using this type of template there is no reason to have to layout the 3 jobs in FastARTIST first, 
simply send three separate jobs and FastRIP will handle the layout for you. 

Note: This also improves the overall RIP performance.
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Multiple Layout

This example template layout shows a possible template for printing tennis balls, all of the slots 
are slot 1 and this means when an image is added it will be duplicated in all the slots and is a 
simple way of printing the same image on many Tennis balls at once.

Note: Select Scale to fit, under Scaling on the first slot so the job will be scaled down to fit inside the slot area, in  
        each slot number.

Simply add a job and 
the job is scaled and 
correctly laid out 
ready for output.

 

Slots can also be setup 
with different sizes 
(even if they share the 
same slot number).
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Shirt and Cap Layout

This is a template layout that 
will print a T-shirt and a Cap 
from the same image.

Both slots are set to the same 
slot number and because they 
are different sizes both use the 
Scale to Fit Always, so that the 
image will be scaled to the cor-
rect size for the shirt board and 
the cap board.

The Shirt board is set for rotate 
270, as the neck of the shirt will 
be loaded on the left and the cap 
will be no rotation.

When a job is imported 
into FastRIP the job is scaled and 
correctly laid out ready for 
output for both a T-shirt and a 
Cap.

 
 
 

Printing Template Slots

When printing to slots in a template, you may want to scale and position your job in 
FastARTIST or application of your choice such as PhotoShop.  As the template slots are user 
definable, you will still want a way to create custom page sizes to match the slot size.  

You can do this using the custom page size feature in the File – Print – page setup dialog (you 
will find this in advanced) or in the Page setup in FastRIP setup, there is a custom option.

Setup the custom page to match your slot size and you can then position and size your job ap-
propriately. 

NOTE: This only applies if you want to avoid scaling and positioning in FastRIP.
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Templates hot folder

Queue Pull-down Menu>>Properties>>Hot Folder tab

Templates come with their own Hot Folder support, providing an automated way of using 
templates. This is ideal for users who want to setup work flows with minimum or no interaction 
with the FastRIP workspace.  It can be used with Internet front ends, in which customers could 
upload files via the Internet and then placed in the correct hot folder for printing to the correct 
board or with additional front end software to avoid actual interaction with FastRIP.

To enable the Template Hot Folder:

Go to `` Queue Properties under the Queue Pull-down Menu and select 
the Hot Folder tab.

Tick the appropriate checkbox.``

Set the `` Hot Folder location. A window will open up requesting a Hot 
Folder location.

You can select whether or not you would like the print file to be deleted ``
on completion.

Setting up a Hot Folder

To setup a 1.	 Template Hot 
Folder, first create a master 
folder (directory) on your lo-
cal machine or across a local 
network. 

Then go to 2.	 Queue Pull-
down Menu>>Properties>> 
Hot Folders tab.

Tick the 3.	 Enable template 
Hot Folders checkbox.

In the 4.	 Browse For Folder 
window, browse for the 
master folder (directory) you 
created in Step 1.

Click OK5.	
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Using the Template Hot Folder

After setting the Hot Folder, FastRIP 
automatically creates a subfolder in the 
directory for each of your templates.

 

Simply by adding jobs into the 
“named” template folder, the jobs will 
be added to your queue, using that 
template.  The jobs are added in Ex-
press mode.

 

In this example, a 3-up folder, there is a 
folder representing each slot number. 

So if you add a job to the root of this 
folder it gets added to the queue using 
this template in Express mode, but if 
you add the job into one of the sub-
folders labeled “1”, “2” or “3”, then the 
job will be added to that particular slot 
of that template.

It’s easy to use hot folders for templates and have complete control over which template and slot 
is used for printing the job.

Layout Manager Tab
Queue Pull-down Menu>>Properties >> Layout Manager tab 

To access the Queue Properties dialog, from the Queue Pull-down Menu, select Properties and 
then click the Layout Manager tab. The Layout Manager tab is used to schedule jobs and man-
age jobs that exceed the media size.
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The available controls will vary according to the model of printer, the Layout Mode selection (if 
available), and whether Tools menu >> Options >> Show Advanced Settings is enabled. 

NOTE: If the queue is Stopped, then all jobs are automatically placed on Hold, regardless of the Output  
        Scheduling settings.

Setting the Layout and Scheduling
Queue Pull-down Menu>> Properties >> Layout Manager tab >> Output Scheduling 

The following sections contain brief summaries of layout and scheduling controls that affect 
how jobs are processed when received by FastRIP. From the Queue Pull-down Menu, choose 
Properties >> Layout Manager tab >> Output Scheduling to access the Layout and Scheduling 
Features.
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Scheduling Settings

Queue menu >> Properties >> Layout Manager tab 

The Output Scheduling controls are set according to the type of job. For example, if the printer 
and cutter are separate devices, then it would be desirable to hold the cut portion of the job, 
until the media has been loaded into the cutter.

From the `` Queue menu, choose Properties >> Layout Manager tab >> 
Output Scheduling.

The scheduling controls are differentiated according to print jobs, cut jobs ``
and  print & cut jobs (i.e., print jobs that include cutting data).
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Layout Jobs As They Arrive

Queue menu >> Properties >> Layout Manager tab

When jobs are received, the default behavior is that they are “scheduled” (i.e., put in the active 
list, and positioned in the Preview Pane). However, this behavior is toggled per the “Layout jobs 
on page as they arrive” checkbox.

ON``  = incoming jobs will be placed in the active list, and positioned in 
the Preview Pane

OFF``  = place jobs in the unscheduled list 
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Chapter 7

Printing From 
Graphics Applications
Introduction

The following section detail how to print from specific software applications like, Adobe Photo-
shop and Illustrator as well as Corel Draw. Since the Windows Print Menu works the same no 
matter what program you are using, there are very few differences when printing from different 
applications. 

As long as you remember to select the proper FastRIP printer, you will be ready to print. Even if 
you forget to go to Properties and select Advanced, FastRIP will work because the Current Set-
ting default prints the Standard Density function of FastRIP.

In many cases, it will be easier to use specific file types having a transparent backgroud to import 
into FastRIP and print using FastRIP print settings. This allows you to print underbase without 
the use of FastARTIST or the complicating Windows Underbase Method.

Basic Printing from any Application
Sending a print job

Printing to FastRIP is like printing to a desktop printer. For example, suppose that your Win-
dows application uses the standard Print dialog.

1)	 From the Windows application File menu, choose Print.

2)	 The Print dialog will open.

3)	 Choose the name of your printer from the drop-list.

4)	 The printer description should indicate that it is a “FastRIP” type of print 
destination, which indicates that print jobs will be processed through FastRIP.

5)	 If the printer description does not indicate “FastRIP,” then search for another 
printer name from the drop-list.

6)	 Click OK to send the print job.

NOTE: If you want to print Underbase without FastARTIST or the use of transparent images, refer to the  
        Windows Underbase Method, later in this chapter, or consult your T-Jet User’s Manual.
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Using Photoshop Images
In PhotoShop, the File menu >> Print command is not capable of retaining the underbase 
information that was prepared for the image. As such, it is necessary to save your image in either 
PSD, TIFF or PNG format, which can then be brought into FastRIP by either the drag and drop 
method, or selecting File>>Import in FastRIP. You will want your image to have a transparent 
background for full underbase settings and options. Photoshop has a number of different tools to 
do this as well as the KnockMeColor and BlackOut Plug-ins provided with FastRIP 10.0.

If you need more of an automated system of printing, it is possible to configure a Hot Folder in 
FastRIP, such that saving your image is automatically detected and printed.

For more information on Hot Folders and Transparent Printing settings in FastRIP, refer to 
Chapter 8 - FastRIP Print Options.

Photoshop KnockOut Plug-Ins
FastRIP 10.0 comes with our legendary Knock-out Photoshop Plug-ins that allow you to knock 
out the background of complex and simple background images while giving you the option to 
view the art with an underbase or different shirt color backgrounds.

KnockMeBlackOut `` - This plug-in is optimized for creating an underbase 
for either black or near-black colors. If you have an image that already has 
a black background, and you want to print onto a black shirt, then this 
plug-in provides a one-hit sequence for preparing the image. 

KnockMeColorOut``  - This plug-in can be used to remove any color (in-
cluding white). For example, if printing to a red shirt with an image that 
has a red background, this plug-in can remove a specific percentage of 
that red from the image as a one-hit preparation. Though this filter can be 
also used for removing black, it is recommended that you use the Knock-
MeBlackOut filter instead. 

Image Preparation

Before running these plug-ins for your image, ensure that the image is on its own layer, and 
NOT on the default Background layer.
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To do this, select from the Layers Pull-down Menu, Duplicate Layer. 
A second layer will be visible in the layers palette named “Back-
ground Copy”. You now have a duplicate of the default background 
layer that you name and apply actions to, separately.

You will need to be familiar with editing layers in your design, as it is 
not possible to setup an underbase on the default Background layer.

Using KnockMeBlackOut

This plug-in is optimized for creating an underbase for either black or near-black colors. If you 
have an image that already has a black background, and you want to print onto a black shirt, 
then this plug-in provides a one-hit sequence for preparing the image.

The KnockMeBlackOut Dialog allows you to remove black and gray backgrounds from your 
images and preview the result. To open up the KnockMeBlackOut Dialog, select it from the 
FastARTIST flyout of the Filter Pull-down Menu. 
 
The window will display the 
original image above a preview 
of how it will appear with the 
black background knocked out. 
By adjusting the Underbase 
strength, shades of gray can be 
included with the knocked out 
portions.

Generally, this plug-in is opti-
mized for creating an underbase 
for either black or near-black 
colors. If you have an image 
that already has a black back-
ground, and you want to print 
onto a black shirt, then this 
plug-in effectively provides a 
one-hit sequence for preparing 
the image.

Preview `` – The original image is shown above the filtered image. At the 
bottom-right is a zoom control for inspecting the filter results. When the 
zoomed image does not fit within the available space, click and drag to 
reposition the preview.
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Transparent `` – This is a preview mode that shows how the image will ap-
pear once it is saved back to PhotoShop. This is the best view for inspect-
ing the color that will be printed.

Show Underbase `` – This preview mode shows the white underbase that 
will be created. Note that the preview is inverted, such that black areas 
represents the white underbase, and the white areas will not be applied 
with underbase.

Shirt Color `` – This preview mode combines the shirt color, underbase 
and color components to show the preview as it would appear on the 
finished shirt. The color picker can be used to choose the specific hue that 
represents the shirt color.

Underbase `` – Use this field to adjust the underbase strength (0..255) that 
will be applied to the shirt. The default underbase setting is 64 (about 
25% of maximum). Increasing this value will cause more Underbase (and 
a corresponding amount of color) to be laid down when printing.

Reset `` – Set all the dialog controls to their recommended defaults.

Changing the underbase setting does 
not change areas that will have 
100% white ink in the underbase, 
nor areas that require no white ink 
in the underbase. Instead, the 
underbase setting will change the 
amount of white ink used to blend 
the black color (of the shirt) into 
the color of the graphics. As more 
white ink is used (i.e., in the 
shadow regions of the image), 
more ink in the color pass will be 
required in order to maintain the 
shadow.

The end result is that shadow 
regions will be lighter and more 
visible.

In the Show Underbase preview 
mode, black portions show where 
the underbase will be applied.

In the Shirt Color preview mode, 
the underbase and the finished 
design are previewed on the shirt 
(shown here as red).
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The Underbase slider controls how much white underbase to put down. Naturally, increasing this 
value will lay down more underbase (i.e., spot white). However, as a consequence of laying down 
more underbase, a corresponding increase in colors will occur to balance this.

This is a clipped area of the original 
image. In this example, we’ll use this 
image with the KnockMeBlackOut 
Plug-in.

Here are all three preview modes with the default Underbase of 64. From left to right, the 
preview modes are listed below.

Here are the same preview modes with the Underbase set at it’s maximum level of 255.

Transparent			        Show Underbase			    Shirt Color

Transparent			        Show Underbase			    Shirt Color
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Using KnockMeColorOut

The KnockMeColorOut plug-in is similar to the KnockMeBlackOut dialog, except that a spe-
cific hue can now be selected and removed from the image.

The KnockMeColorOut Dialog allows you to remove any color background from your im-
ages and preview the result. To open up the KnockMeColorOut Dialog, select it from the 
FastARTIST flyout of the Filter Pull-down Menu.

Click on the original (top) image.1.	

Next, click the “Color to Remove” color picker and sample the color to remove.2.	

Again, the rest of the tools and options in the KnockMeColorOut Dialog (Preview modes-trans-
parent, shirt color, Show Underbase, the Preview Window, Underbase Strength etc.) will work 
much like the ones in the KnockMeBlackOut Dialog.
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The Underbase setting can vary from 0 to 1000, with a default of 100 (i.e., 10%). In the follow-
ing two images, Underbase settings of 100 and 650 have been applied. At the higher Underbase 
setting, less ink will be applied, allowing more of the shirt color (e.g., a red shirt) to show 
through and blend with the image.

If the shirt color were black, then the Underbase setting of 100 would be suitable because more 
of the red image background would be retained. However, if the shirt color were red, then an 
Underbase setting of 650 would allow a more natural blend between image background and the 
shirt color.

With an Underbase setting of 100, only about 10% 

of the selected hue is “knocked out,” which provides a 

greater background contrast with the shirt color. This 

would be appropriate when printing onto a black shirt, 

so as to retain more of the red image.

With an Underbase setting of 650 (65%), this would be 

appropriate for printing to a red shirt. Less ink would be 

used to print the image color, thereby allowing the image 

to blend more naturally into the shirt color.
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Apply Soft Edges Using KnockMeColorOut

The KnockMeColorOut plug-in can also be used to help with blending soft edges into the shirt 
color. For example, Fig. 11 shows the image of a doe that needs to be applied to a black shirt. 
However, if we merely perform a blanket knockout of the white background, then the result is a 
white halo effect that (usually) detracts from the image quality.

If we inspect a small region of the doe’s back, then we can see why this happens. The fur of the 
doe is difficult to select and remove correctly. Though increasing the tolerance of the Magic 
Wand tool can capture more of the off-white pixels, removing bits of the off-white fur will 
produce a hard edge that detracts from a natural image. What is really needed here is to retain 
the fur and blend it into the black of the shirt.

For the image on the left, we want to knock out the white background for application to a black shirt. However, the preview on 

the right shows that off-white pixels will create a halo effect around the doe.

By increasing the Overprint setting, more of the white halo is removed. However, fine detail is lost (i.e., the doe hair).
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The solution is to create a duplicate layer of the image, then use the Magic Wand tool to clean 
the outer contour of the underlying layer image.

The KnockMeColorOut tool can then be applied to the top-most image to remove white and 
off-white. Adjust the Underbase setting to achieve the desired blend of fur with the black shirt 
background. This will remove the white spots from the top-most image, but the white spots from 
the underlying image will now show through (thereby preserving the image quality).

On the left, the Magic Wand tool was used to carefully remove the off-white portions along the fur, including the hairs of the fur. On 

the right, we have a second layer copy of the doe with fur intact.

The KnockMeColorOut can now be applied to the top image. This removes off-

white from along the hairline, though removes white from the animal pelt as well.
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Once the top image is ready, use the Layers Pull-down Menu > Merge Layer command to com-
bine it with the underlying layer image. The image is now ready for application to a black shirt. 
Using these techniques, you can blend even complex images like fur and hair into your shirt, 
thereby obtaining the highest quality t-shirt printing results.

Other Photoshop Background Removal 
Methods

In order to make removing backgrounds as easy as possible, try to maintain a consistent/neutral 
background if possible. For example, if photographing the motorcycle shown on the following 
page, park in front of a wall or a background that contains a much lighter color than the bike. 
This will help Photoshop determine the difference between the selected background and the 
object (such as the motorcycle) you intend to keep. 

Using the Magic Wand – Click and Delete

With the Magic Wand, click on the unwanted areas around the image and then delete them. It’s 
a pretty simple process IF the background color is different 
(contrasting) from any of the edges of your image.

Once white has been removed from the top image, right-click the layer and choose Merge Down. This 

will combine the top image with the underlying image (which still has the white spots on its coat).
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Click an area in the background and 
the Magic Wand will make a selection 
around the image. If the “marching ants” 
selection goes into the main design, change 
the Tolerance on the Property Bar. The 
default is 32. Note: if you are working on a 
“flattened” piece of art (JPEG) with 1 layer 
named: “Background,” you need to first 
duplicate this layer to switch to “PSD file 
mode” to get the transparent background. 
The original layer can then be deleted.

Depending upon the variations and gradients in the background, 
it may require some trial and error with Tolerance settings and several selec-
tions before the background is completely removed.

If the first click of the Magic Wand does not get all the unwanted areas, you 
can add to the selection by holding down the [Shift] key and clicking anoth-
er area. You can subtract from the selection by holding down the [Alt] key 
and clicking on a area.

Photoshop and FastARTIST both have Magic Wand tools (it looks like a 
wand with a sparkler on the end.)

Using the Extract Filter

Photoshop also has a Filter called 
Extract. This will allow you to draw 
around an image and fill the center with 
color. Photoshop then removes all the 
areas around the image, leaving you with 
a transparent background. Extract does 
a decent job, but the Magic Wand is the 
preferred method.

NOTE: Keep in mind, the Magic Wand and Extract filters perform best when the background is a solid 
color and not a gradient.
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Making Your Selection a New Layer

The goal behind all this is to get your main 
image on a layer with a transparent back-
ground. (This will show as a gray and white 
checkered pattern throughout the image). 
With a transparent background, you can 
add additional elements to the image includ-
ing text, drop shadows, glows and more.

Color Range

Under the PhotoShop Select menu, the 
Color Range tool is used to select a specific hue (or range of hues). However, for black or near-
black, the KnockMeBlackOut performs significantly better than Color Range. 

For other hues (including white), both `` Color Range and KnockMe-
ColorOut will produce comparable results. However, the advantage of 
KnockMeColorOut is its ability to show results in three preview modes 
(Transparent, Show Underbase, and Shirt Color).

Transparent Photoshop Image Formats

As mentioned earlier, in PhotoShop, the File menu >> Print command is not capable of retaining 
the underbase information that was prepared for the image. As such, it is necessary to save your 
image in either PSD, TIFF or PNG format, which can then be brought into FastRIP by either the 
drag and drop method, or selecting File>>Import in FastRIP.  Below is a brief overview of the 
acceptable transparent file types and their uses, pros and cons.

PSD FORMAT

Saving in PSD format is encouraged because it provides the greatest com-``
patibility when making further edits in PhotoShop.

Before saving the image, make certain that there will be maximum com-``
patibility between PSD and PSB files. This can be set via Edit menu >> 
Preferences >> File Handling >> Maximize PSD and PSB File Com-
patibility = Always.
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Alternatively, this can be set to `` Ask, which will prompt you each time 
that a PSD file is saved.

With maximum compatibility with PSB, most PSD files should work ``
without issue. However, if your image is composed of multiple layers, 
particularly with text and objects each with their own underbase, then it 
may be necessary to save the image as a single layer job. Use the Layers 
menu >> Merge Layers command to collapse such layers before saving.

When saving, always tick the `` ICC Profile checkbox, such that an embed-
ded profile is saved with the image.

TIFF FORMAT

When saving in TIFF format, tick the Layers checkbox.``

When saving, always tick the ICC profile checkbox, such that an embed-``
ded profile is saved with the image.

If available, then tick the Save Transparency checkbox.``

PNG FORMAT

The PNG format does not support the embedding of color profiles. As ``
such, more care might be required to ensure that the correct profiles are 
used with the PNG file, especially if you are reusing a PNG file from a 
previous job.

JPEG FORMAT

Saving as JPEG is not workable. Though the specification for JPEG files ``
does allow for storing underbase information, PhotoShop does not cur-
rently support storing of underbase information in JPEG format.
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Printing from Vector Applications
Corel Draw and Adobe Illustrator are good examples of Vector Applications. For full underbase 
control, practice using the Transparent Image method and setup your print settings directly 
inside of FastRIP.

Exporting Art for Printing

We recommend exporting art (unless using FastARTIST in conjunction) into one of the formats 
described in the previous section (PSD, TIFF or PNG). If you export correctly, you may not 
even need to own Photoshop to import the images into FastRIP. The following is an example 
of the steps you would take and should apply the same in most Vector Applications.

Select File>>Export``

Select Export Type:  A Export dialog will open with a field to enter a ``
name as well as a drop-down or list of available export file types. Se-
lect either PSD, TIFF or PNG (see previous section for descriptions).

Set File Options: Depending on what file type, there will be separate ``
options. 
 
PSD: Select High Resolution (300dpi) or click other and set desired; 
select write layers - note that your image needs to be converted to 1 
layer or the psd file will have multiple layers. 
 
TIF: Select High Resolution (300dpi) or click other and set desired 
 
PNG: Select High Resolution (300dpi) or click other and set desired; 
select Transparent for Background Color.

NOTE: If printing using FastARTIST, refer to your FastARTIST User’s Manual for instructions on converting vector 
files over to FastARTIST.

Printing Complex Files
Files created in Vector-based programs like Adobe Illustrator, Macromedia Freehand, Corel-
DRAW, or QuarkXPress can create complex files. FastRIP has an option called Complex Line 
Art that will send the data to FastRIP as one piece instead of in sections. Not all files will need 
the Complex Line Art option, but if your image has complex shapes, gradients, transparencies 
or heavy use of the mesh tool then you might wish to use the Complex Line Art option before 
printing .

To select the Complex Line Art option:
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Open FastRIP .1.	

Open your file in the graphics program.	2.	

Set up your separations for printing.3.	

Go to 4.	 File > Page Setup or Print Setup. Select the FastRIP printer. Click on Ok.

Go to 5.	 File > Print. Click the General tab and select Printer Extensions 2. Bring 
Current Settings down for Device Select. Choose Complex Line Art.

Print the file through FastRIP .6.	

NOTE: If the file still will not print, select one Spot Color to print and allocate more memory to FastRIP.

The Windows Underbase Method
The Windows Underbase Method is used to create an underbase and with FastRIP 10.0, is only 
necessary only if you cannot create a transparent image or do not have FastARTIST. Unless  you 
are familiar with this method, it may be worth while to invest in a Background knock-out like 
FluidMask.

Essentially, this technique requires you to specify where you don’t want an underbase by setting 
all such pixels to pure white at RGB(255, 255, 255). However, the limitations of this method 
are:

The print preview will not provide a reasonable indication of where the ``
underbase will be applied.

The underbase will generally be limited to harsh transitions, as opposed ``
to allowing for gradients (i.e., a gradual tint underbase, such as for a red 
gradient that blends to the shirt color.

NOTE: Refer to your T-Jet User’s Manual for further instructions.
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Chapter 8

FastRIP Print 
Options
Introduction

FastRIP has many different options that you can enable and control. This chapter will cover the 
basic controls and options features of FastRIP 10.0.

NOTE: If you always rely on your graphics application to open FastRIP you may experience occasional errors or 
output issues. For that reason, we recommend you open FastRIP before sending a Print command from your graphics 
application.

     

Print Controls
Starting and Stopping Print Jobs

When print jobs are received by FastRIP, they can be either printed immediately, or they can be 
collected for later printing. The main controls for controlling print jobs are the Start Queue and 
Stop Queue buttons (available from the FastRIP toolbar). The Start Queue and Stop Queue 
commands are also available under the Queue menu.

If the Start Queue button has been clicked, then print jobs will be printed immediately. If the 
Stop Queue button has been clicked, then print jobs will be held until manually released.

A held job can be printed by right-clicking the job and choosing Print from the context-menu. 
Alternatively, select the job and choose Print from the Jobs menu.

In addition to the Start Queue and Stop Queue buttons, the scheduling settings also control 
whether a job is printed or held. The scheduling controls are set via Queue menu >> Properties 
>> Layout Manager tab.
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Cancelling a Print Job

1.	 Pause the job on the printer control panel.

2.	 In FastRIP 10, right-click the job and choose Abort.

3.	 Windows will open a Port Locked dialog. Do not close this dialog.

4.	 From the printer control panel, reset the printer. If there is no reset button (or procedure for 
resetting the printer), then turn the printer OFF. After powering OFF, power the printer ON 
after a short pause.

5.	 Return to the Port Locked dialog and click OK to continue.

At this point, the printer should be ready to process new jobs, and buffer data from the cancelled 
job will have been cleared.

Printing to a Hot Folder
The Hot Folder is simply a directory on the workstation hard drive that will be monitored for 
new print (i.e., PostScript) files. If any print files are placed in the directory, then these will be 
added to the queue as new print jobs.

Typically, the Hot Folder is used by other graphic designers on your computer network. They 
will copy their jobs into the Hot Folder, and your workstation queue will then be able to process 
those jobs. However, please note that other graphic designers will need the appropriate file access 
permission (as granted by your network administrator) to copy files into the hot folder.

In FastRIP, a hot folder is designated as follows:

1)	 From the Queue menu, choose Properties.

2)	 On the Queue Properties dialog, click the Hot Folders tab.

3)	 Tick the Enable queue hot folder checkbox.

4)	 A browse dialog will open.

5)	 Choose a directory and click OK.

When a PostScript job is placed within the hot folder, FastRIP will use print mode settings that 
are contained within the PostScript file. If the print mode settings are missing or incomplete, 
then the Queue Properties will be used to complete missing settings.
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Printer Options Tab
Queue Pull-down Menu>>Properties>>Printer 
Options tab

In the Queue Properties dialog, the Printer Op-
tions tab provides access to printer-specific op-
tions within the print mode. These printer-spe-
cific options are defined within the print mode, 
such as plane order, knife speed, etc. Please note 
that these options vary according to the printer 
model. For more information about these set-
tings, please consult the operator manual that 
was provided with the printer.

Previewing Print Data - View Raw Data
Print data can be examined on-screen prior to printing. This is typically done in order to confirm 
the print data that is available in each color channel.

For example, suppose that a gray-
scale image needs to be printed, 
and the expectation is that only the 
black (K) channel will receive print 
data. This can be confirmed in the 
following manner:

1)	 Click the Stop Queue but-
ton to pause the grayscale-
only print job in the queue.

2)	 Right-click the job and 
choose RIP Only. When 
the job has finished spool-
ing, its Status will indicate 
“Holding [Job spooled]”

4)	 Right-click the job and choose View RAW data.

5)	 Click the Plane Select button. Each of the color channel checkboxes will be 
checked.

6)	 Untick the Black checkbox. The preview should now be blank because the 
CMY channels are not being sent data for a grayscale-only job.

Note: Colors appear differently on monitors than they appear when printed. As a result, the View Raw Data  
        feature will not show colors on the screen exactly as they will appear when printed.
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View Raw Data Window Options

In the View Raw Data Window, you will notice a toolbar offering several options. These options 
are outlined below.

Save

Select the Save button to save the picture as a bitmap image for comparisons or later viewing.

Print

Select the Print button to print the preview. For example, the preview can be printed to a desk-
top printer for use as a sample.

Zoom Tools

Select Zoom In, Zoom Out, or select a Percent Zoom to view the image as a whole, or particular 
sections within the image.

Color Planes

Clicking the Planes Select button opens the Select Planes to View dialog. The color channels 
used to print the image will be listed. Unchecking color channels is useful as a means of confirm-
ing the inks that will be used when rendering the image. 
 
For example, suppose that a CMYK printer is being used to print a grayscale image using only 
the Black (K) channel:

1.	 Click the Plane Select button. Each of the color channel checkboxes will be 
checked.

2.	 Uncheck the Black checkbox.

3.	 The preview should now be blank because the CMY channels are not being 
sent data. 
 
Substrate Color: The Substrate button (at the bottom) will open up a color 
picker window that indicate the media color. Alternatively, the color picker 
can be used to simulate different media colors.

1.	 Click the Background color picker.

2.	 Choose color that best matches the media color.

3.	 Click OK to view the spool data on the new media color.

Zoom 
In

Print Zoom 
Out

Zoom 
Selection

Color Plane 
Selection

Configure

Image 
Information

Save
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Configuration

Click the Configure button to open the Preview Configuration dialog. 

Treat Process as Spot ``
This option is typically off. However, when viewing color separations that 
are a combination of process and spot colors, setting this option = ON 
can help to obtain an improved view of the color blends.

Show True Pixels Resolution ``
Many printers have different horizontal and vertical resolutions. The 
image that appears in the viewer is automatically adjusted to account for 
this, when Show true pixels resolution is unchecked. Checking Show true 
pixels resolution will show the image without this automatic adjustment, 
which will cause the image to appear stretched.

Cache Size ``
If the viewer is drawing too slowly, and additional memory is available on 
the hard drive, then increase the size of the memory cache to increase the 
viewer speed. 

Units ``
Select the units of measurement from the drop list (pixels, inches, or cen-
timeters). The units of measurement appear in the bottom right corner of 
the View Raw Data dialog.

Image Information

Clicking the Image Info button will open an Image Info dialog. The dialog includes a list of 
information specific to the image including the printer, resolution, color planes, image size, and 
file location. 

View as Black

Check the View as Black option to change the background color to white, and all other colors to 
black, within the image preview.

Variable Dot Halftone Previews

Variable dot halftone support is incorporated into the print modes provided with FastRIP. By 
applying one of the FastRIP-provided print modes, variable dot halftones will be automatically 
used with the given print job.

With respect to on-screen previews, note that a monitor display is not capable of previewing vari-
able dot output because a monitor display contains only one size of pixel on-screen. Further, the 
limited number of monitor pixels may cause the preview to appear faded, though this fading will 
not be present in the actual print.
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Archiving Print Jobs
Print jobs can be archived as a combined JTB file that contains the job data and log data, such 
that the JTB can be safety stored (i.e., backups) and then restored at a later date, saving time 
from respooling a file as well as preventing any “guess work” in the job settings, etc. Archiving a 
job in this fashion is convenient because the log and notes related to the job are preserved, such 
that specifics about the job will be available upon restoration.

NOTE: keep in mind that spool files require relatively much more hard drive space than PostScript files.

Enable Archiving

Queue Pull-down Menu>>Properties>>Archiving tab

The Archiving tab in the Queue Properties dialog offers a few functions, one of which allows you 
to enable the Archiving function.

This dialog also gives you the option to save the spool file on job completion and gives statistics 
of how many jobs have been archived. 

NOTE: You can also enable job archiving by right clicking on a completed job and selecting properties>>Show  
        for page output (or Show for page content)>>Archiving tab.
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Archiving a Job

1.	 Right-click the job and choose Properties. If the job has already been spooled 
(printed) a flyout menu will open; select either Show for Page Output or 
Show for Page Content. Both options will open the Job Ticket Properties 
Dialog. Note: if selecting Show for Page Content, there will be a few more 
options, such as compression settings etc. For typical  output archiving, select 
Show for Page Output.

2.	 Select the Archiving tab.

3.	 Tick the Enable job archiving checkbox (if not already).

4.	 To cause the spooled print data to be included with the archive (optional), tick 
the Spool checkbox. Note that spool files are quite large in comparison to the 
corresponding original PostScript file.

5.	 Under Archive Job Ticket, confirm that the Location indicates where you 
want the archive file to be stored. To set the destination, click the  
button.

6.	 Click the Archive button.

7.	 You will be prompted to name the archive file.

The archive will now be created at the given location (stored as a JTB file type). 
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Restoring an Archived Job

Jobs Pull-down Menu>>Restore Jobs: The Restore Job Tickets dialog allows you to restore a se-
lected job or multiple jobs, delete archives or browse other locations for archives saved in separate 
locations. 

1.	 From the FastRIP window, select a Queue Tab to indicate which queue you 
want the job to be restored to.

2.	 From the Jobs Pull-down Menu, choose Restore Jobs.

3.	 The Restore Job 
Tickets dialog 
will open.

4.	 Select the job 
archive that 
you want to 
restore.

5.	 Click the Re-
store Archive 
button.

6.	 Click the Close 
button.

NOTE: The default list of jobs that appear in the Restore Job Tickets window will only reflect the location of the  
        most recent archived job or jobs. To browse other locations, click the button.

Printing Direct To Port
Under the Tools menu, selecting Direct 
To Port will open a Send to Port dialog. 
Image files can be drag-and-dropped into 
this window to initiate a print job. The job 
will bypass the queue and be sent directly 
to whichever printer is connected to that 
port, without any processing.

From the drop-list, select the port where 
the print jobs will be sent. To the right of 
the drop-list, click the button to edit the port settings.

Note: This is a quick, specialized method of sending a print job, such as testing output.

Drag and Drop Files Here
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Importing a File and Import Options
From the FastRIP 10 toolbar, the Open button can be clicked to import an image file (e.g., EPS, 
BMP, TIFF, etc.) or you can select File>>Import.  
 
Alternatively, an image file can also be drag-and-dropped onto the FastRIP 10 window, causing 
that file to be imported. In either 
case, the File Import Options are 
applied when importing the given 
file.

Scaling`` : 
This Option lets you scale 
the image either by preserv-
ing the aspect ratio (check-
box) or changing it to fit 
your needs.

Optimize Image for Speed`` : 
This option will downsize 
unnecessary file sizes in 
order to print faster.

`` Always use these settings when importing: This option will allow you 
to use the same import settings for all file types. 
 
If checked, the Image Import dialog will 
no longer open every time you import 
an image. In this case, to gain access to 
this dialog in the future, go to 
Queue>>Properties>>Import Options 
tab. 
 
Uncheck the Hide Image Import 
dialog and use the following settings 
checkbox. This will gray out the screen 
and allow you to make the necessary 
settings each time you import an image 
into FastRIP. 

NOTE: Refer to following section for addition Import Options.



Chapter 8 - FastRIP Print Options

84
FastRIP 10.0 User’s Manual     for ITG

Underbase Settings in FastRIP Using 
Transparent Images

Images saved with transparency can be output directly from FastRIP and the Underbase created 
automatically from the transparency information.

NOTE: You cannot create an Underbase using the File>Print method because the File>Print process flattens the  
        file and loses all the transparency information.

FastRIP supports two methods of creating an Underbase.

Windows Underbase that can be applied to any job by utilizing the ap-``
plication print options.

Underbase from transparency, which can only be applied to bitmap im-``
ages with transparency information (file types PSD, TIF or PNG)

While the Windows Underbase does allow you to work with any file type and from any program, 
the Underbase from transparency does offer major advantages such as choking / trapping the 
Underbase, Highlight White and blends between the graphics and the shirt.

NOTE: If using FastARTIST in conjunction with FastRIP 10, refer to the FastARTIST User’s Manual for more  
        Underbase Options.

Import Options and Settings

File>>Import

The Image Import dialog window opens anytime you import a job into FastRIP. This window 
allows control of the image and properties prior to importing. Since FastRIP 10 recognizes 
transparent files, the Import Options dialog will include extra options for the Underbase and 
other options such as passes and a highlight white option, when importing a transparent file. 

In the FastRIP window, select 1.	 Import from the File Pull-down Menu. Another 
way to import a file is to drag and drop the file directly into the queue active list.

NOTE: For Hot Folder options, see previous section, Printing from a Hot Folder).



85
Version 1.2    Revised  March, 2009

Chapter 8 - FastRIP Print Options 

2.	 Select Yes to “Do you want to create a Underbase from the transparency layer”. 

NOTE: If you do not need an Underbase or do not care about the extra options, you can leave this as No and set  
        the job up as if the file were a non-transparent image.

Select the 3.	 Underbase Print Mode and other options.

Select Print Mode

Consult your Printer Manual for information on Underbase Print Modes.

Underbase Strength:

This has 4 settings for determining the Underbase to be created.

None`` : Doesn’t create an Underbase, would only typically be used if you 
just wanted a highlight white on the image

Minimum`` : Converts the transparency information to an Underbase and 
then process’s the Underbase to remove areas of the Underbase were the 
colors in the main image are black (as you do not need to print white 
under black).  
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The Minimum setting uses the least amount of ink for the Underbase 
and is equivalent to the Normal Underbase setting in the FastRTIST 
Underbase Wizard.

Medium`` : Converts the transparency information to an Underbase and 
then process’s the Underbase to remove areas of the Underbase were the 
colors in the main image are black (as you do not need to print white 
under black). 
 
The Medium setting is best at maintaining colors and darker shadows 
and is equivalent to the Heavy Underbase setting in the FastARTIST 
Underbase Wizard.

Strong`` : Will create an Underbase from the transparency without modifi-
cation.

Note: Medium is recommended setting, minimum will use the least amount of white ink.

Gamma adjustment

Gamma is another term for the levels adjustment found in programs like PhotoShop. Gamma 
Adjustment applies a gamma adjustment to the white Underbase either lightening or darkening 
the midtones and has a small proportional effect on highlights and shadows. 100% pure color 
and 0% pure color are not affected at all. 

Gamma Adjustment  is very useful for controlling the amount of white used when blending in a 
graphic with the shirt color and as an additional trapping tool.  A low value will put down less 
white ink where the image is partially transparent, while a high value will put down more black 
ink in the same area.

This graphic shows the gamma effect on a white 
underbase gradient with values of 10, 128 and 
245, so higher values will use more white under 
partial transparent areas (to much can create 
a white halo effect) smaller values will use less 
white and act as a choke on the white underbase 
in these areas.  Too little and all that will show 
through though is the shirt color. Default is 128.

Choke the Underbase

The Chock the Underbase options have 5 different settings. These settings are used when the 
Underbase is created to choke / trap or shrink the white Underbase so that when printing, the 
white ink area is smaller than the color print area and stops any white showing due to registra-
tion or bleed problems.
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None – Applies no choke to the Underbase``

Minimum – Applies a choke of equivalent to 2 pixels at 720dpi``

Medium  – Applies a choke of equivalent to 3 pixels at 720dpi``

Maximum – Applies a choke of equivalent to 5 pixels at 720dpi``

Extreme  – Applies a choke of equivalent to 10 pixels at 720dpi ``

Note: The accuracy of the choke depends upon the resolution of the image, (see the AVI’s on choking for more 
information), but typically you want 300/360dpi images to get a good accurate choke.  If you choke too much, then it 
can cause other problems (most noticeable on lighter color shirts) and create what looks like a stroke color around the 
object.  Best defaults are Minimum or Medium for Light color shirts and Medium or Maximum for Black shirts.  You 
should only use this if you have registration issue between the white and color pass.

Highlight White

The Highlight White setting creates a highlight white to be printed as part of the color pass

None – Doesn’t create a highlight white``

Weak – Creates a weak highlight white, uses the least amount of white ``
ink in white areas only.

Medium -  Uses more white ink for the highlight in areas of pure white. ``
The medium setting is similar to the highlight white from the Normal 
Underbase setting in the FastARTIST Underbase Wizard

Strong – Use 100% white ink in areas of pure white. This setting is ``
similar to the highlight white from the Heavy Underbase setting in the 
FastARTIST Underbase Wizard 

Note: Using to much white, especially in the color pass can cause your colors to become washed out.  This 
happens when the White ink and color inks mix.  Its best if you can avoid using a highlight white for DTG and get a 
good white underbase instead. If you do use this, use it sparingly to avoid color shifts, unless you are print just white 
objects.

Underbase Repeats

Underbase Repeats is the number of Underbase passes to be printed.

Color Passes

Color Passes is the number of Color passes to be printed.
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Always Use These Settings When Importing 

This option will allow you to use the same im-
port settings for all file types. 
 
If checked, the Image Import dialog will no 
longer open every time you import an image. 
In this case, to gain access to this dialog in the 
future, go to Queue>>Properties>>Import Op-
tions tab. 
 
Uncheck the “Hide Image Import dialog and 
use the following settings” checkbox. This will 
gray out the screen and allow you to make the 
necessary settings each time you import an im-
age into FastRIP. You can also set a default in this window.

FastARTIST Jobs

Jobs from FastARTIST such as those created with the new Fluid Mask feature or PSD files 
imported into FastARTIST will have there underbase created in FastARTIST, so you will not 
see this dialog.  But will have seen a similar dialog with the same options in FastARTIST when 
importing the image.

Changing The Print Mode For Color Passes

The Print Mode used for the color pass will be 
set using the print mode selected in the queue 
properties (Queue>>Properties>>General tab). 

NOTE: You can change this for a particular job, 
by going to the job properties (right click on job 
and select properties).

If you want to setup a different default, then 
click the drop-down selection arrow under Print 
Mode. You can manually browse for a print 
mode by clicking the  button.

The new changes will then be used for all future 
imports.

IMPORTANT: The Enable Underbase check-
box is for the Windows underbase setting only. Do not use this option for images with 
transparency.  
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Setting up the Substrate Color

Queue Pull-down 
Menu>>Properties>>General tab

By default FastRIP will show you a preview 
of your image on a white shirt, but you can 
configure your queue for any color shirt. From 
the Queue Pull-down Menu, select Properties 
and click the General tab.

Under `` Default Device Settings, 
Substrate Color, click on the Choose 
Color... button.

Select any color from the color picker ``
to use as your shirt color.

All previews will now be displayed with the newly selected background color (shirt color).

Note: If you select black and add a job with no underbase then it will display as solid black and you will not be 
able to see your image (just as it would print..).

Note: For the substrate color preview to work correctly, you must keep Preview Options set on 1-bit per pixel.  See 
Tools - Options – Preview Options
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Costing Interface
Queue Pull-down Menu>>Properties>>Costing tab 

This new feature of FastRIP 10.0 allows you to keep track of costs in several different variables. 
To access the Costing Interface, select Queue from the Pull-down Menu and choose Properties. 
The Queue Properties window will open. Under the Other Tabs, select Costing.
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Material cost 
The material cost can be calculated in one of three ways using the drop down box.

Per Unit ``
A fixed price per print and typically used for T-shirts and other fixed price 
items when printing and will calculate the price using the value entered

Per Square Foot ``
This option, will calculate the price based on the actual area printed using 
the value per square foot.

Per Square Meter ``
This will calculate the price based on the actual area printed using the 
value per square Meter.

Surface Treatment Cost

This can be used for a number of different material treatments, such as a pre treatment for t-shirt 
printing or lamination in large format sign printing

Per Unit, is a fixed price per print and typically used for T-shirts pretreat-``
ment and other fixed price items when the surface treatment is fixed or 
largely an estimated fixed price

Per Square foot, will calculate the price based on the actual area printed ``
using the value per square foot.

Per Square Meter, will calculate the price based on the actual area printed ``
using the value per square Meter.

Black, Colored and White Ink costs

This is always entered per liter, if you don’t buy your ink buy the liter then you will have to cal-
culate the per liter costs by dividing your volume purchased into a liter and multiplying this by 
your cost.  Because on some printers Black ink is cheaper, black ink has been treated as a special 
case.  Also on some machines White ink is more expensive so it also has its own separate costs 
from other colors used.

Notes

Allows you to add a text description, containing any notes you wish.
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Color and White Ink passes

This is so you can enter the number of passes the printer makes when printing color pass or the 
white pass (if printing white). With some printers you select the number of passes when you 
print (or in the general tab), but some printers can control the number of passes internally.  For 
this reason the number of passes you use with print jobs should be set manually in the costing 
interface and match the number of passes you use when you print. 

Note: You can always change this on a job by job basis or you can setup different queues, say one for 2 white  
          passes when doing black shirts and another queue with 1 white pass when doing lighter colored shirts.

Ink Contingency

With all inkjet printers, there is a certain quantity of ink waste that occurs during head cleaning 
and other routine maintenance tasks.  The amount of ink used in these tasks will depend upon 
the printer and also the amount its used (the more you print, normally the lower the ink wastage 
as an overall percentage).  Entering a % in this field will add this to the total ink used and effect 
the cost, so you can factor in the running costs including head cleaning and other maintenance.

 

Labor Cost

All printing requires some labour, from loading the materials, to pre treatments, lamination and 
packaging for shipping.  You have three ways you can calculate this.

Per Unit, is a fixed price per print and typically used for T-shirts and oth-``
er fixed price items when the labour is typically the same for each item.

Per Square foot, will calculate the price based on the actual area printed ``
using the value per square foot.

Per Square Meter, will calculate the price based on the actual area printed ``
using the value per square Meter.

Tax 1
This allows you to apply a tax to the total cost of the job.  Its added as a percentage of the total 
cost of the job

Tax 2
This allows you to apply a tax to the total cost of the job.  Its added as a percentage of the total 
cost of the job when you select regular tax and is includes that costs of Tax 1 when you select Ad-
ditive tax as in some countries / states.
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Time

This does not effect the cost and is just for information purposes. 

Per Unit, is a fixed time per print and typically used for T-shirts and other ``
fixed printing and application timed items.

Per Square foot, will calculate the time based on the actual area printed ``
using the value per square foot.

Per Square Meter, will calculate the time based on the actual area printed ``
using the value per square Meter.

Record Costing Data

You can select to record the costing information automatically, either at the queue level, job level 
or both.  The data is then exported to this location in a .csv format, suitable for importing into 
Excel and relational databases for account and reporting.  Using this feature you can further cus-
tomise the costing as required.  For example if you wanted you can use the information in Excel 
and add time as an additional cost item or process all jobs in a week and calculate total labor 
time.

Dot Profiles 
In order for the costing to be calculated, it required that the software knows what the dot vol-
umes are when printing and these will vary depending upon the resolution and other factors.  
This information is normally provided in the driver (when available).  However you can change 
the dot volumes (based on a per print mode) and / or if they are absent, add your own estimates.

Note: Its often the case that different printing requires different costing, this can be from different material costs,  
         labor costs, pre treatment costs.  The benefit of using the multiple queue system is that you can setup different 
queues for these cases and enter different costing appropriately for the jobs. 

Job Properties – Costing

In order to see the costing, you must first RIP the job (right click and RIP only), you can then 
see the costing tab in the job properties (Right click – properties – show properties for page con-
tent for singe jobs).

This costing will reflect the information entered in the queue properties, but it can be changed.  
For an example, if, for a particular job, you want to change the tax or ink contingency you can.  
You can also change the number of passes, if it differs from the defaults you setup in queue prop-
erties.

It is also possible to get a quick simple print of this information to your desktop printer or export 
the CSV file for use in another program.
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Chapter 9

Print Modes
Print Mode Introduction

About Print Modes
Each FastRIP Print Mode has been painstakingly crafted to obtain high quality output that 
takes into account the absorbency characteristics of the given media, so as to avoid under-inking 
conditions (i.e., pin-holing) and over-inking conditions (i.e., bleeding). As such, the expectation 
is that reliable reproduction will be obtained from your given model of Epson printer, per version 
of FastRIP. The information outlined in this chapter is based on a Blazer Series T-Jet Inkjet-to-
Garment printer. 

Types of Print Modes
There are three basic modes for printing: Cartoon, Photo, and Underbase. The Cartoon and 
Photo Print Modes will print the image in color when printing from FastARTIST or any other 
graphics program. These two modes were created to adjust print characteristics based on the im-
age to be printed.

Cartoon

Cartoon Print Modes should be used if you are printing vector graphics with Spot Colors, hav-
ing no photographic elements, such as shadows or mixed halftones with effects. Cartoon Print 
Modes are designed to lay down more ink with good color saturation and should be used for 
non-critical images. They also allow a lower LPI to be selected (360 x 360).

Photo

Photo Print Modes should be used if you are printing photographic images or images with 
photographic elements, such as shadows or special effects. Photo Print Modes are designed to lay 
down less ink with highly accurate colors, reproduce an extremely detailed image and allows you 
to utilize a higher lpi (1440 x 1440) to ensure the highest print quality possible.

Underbase

Underbase Print Modes are designed exclusively for printing a white Underbase. An underbase is 
needed to print vibrant images on dark garments, but there are different settings that will need to 
take effect in order to get a “soft feel” underbase or a vibrant shirt base for vector graphics. There 
are the exact settings for Underbase Print Modes as there are for Photo and Cartoon, therefore 
it is recommended that you always use a similar, if not the same setting for the Underbase Print 
Mode that is selected for the Photo or Cartoon Print Mode.
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Print Mode Settings
Each Print Mode will have different version or setting applied to it, such as Lines Per Inch (lpi) 
Dots Per Inch (dpi),  as well as High Speed (HS) Bi-directional versions, all which appear in the 
Print Mode Name. 

Lines Per Inch

This setting shows up as 2 numbers (number x number) before the Print Mode Name. The 
numbers represent how many lines are printed per inch. Realistically, the higher the number, the 
longer it will take to print, but the better the print will look.

High Speed (HS)
High Speed Print Modes are marked with an HS at the end of the Print Mode name. If select-
ing a High Speed Print Mode, your image will print out, virtually twice as fast. High Speed Print 
Modes use Bi-directional data meaning that the print head prints in both passes. Other print 
modes only print in on direction.

NOTE: In order to use HS print modes effectively, a Bi-directional Print Head alignment must 
be completed. Refer to your Printer’s User’s Manual for details.

2 Pass

The 2 Pass Print Modes do not effect the original settings, they only add another pass to the orig-
inal Print Mode making the print more vibrant. With this setting, you could combine a 360x360 
print mode with HS and have an image print out somewhat like a 720x720 regular Print Mode. 
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Setting Applying and Saving Print Modes
The following sections will cover using Print Modes and applying them to your designs, hassle 
free. Most of these methods are newly introduced in this version of FastRIP 10.0

Setting The Print Mode From The Print dialog

1)	 From your Windows graphic design application, choose File menu >> Print.

2)	 The Print dialog will open.

3)	 Choose the printer name from the drop-list.

4)	 The printer description should indicate that it is a “FastRIP” type of print destina-
tion, which indicates that print jobs will be processed through FastRIP.

5)	 If the printer description does not indicate “FastRIP,” then search for another 
printer name from the drop-list.

6)	 Click the Properties button.

7)	 The Properties dialog for the driver will open.

8)	 Click the Advanced button.

9)	 The Advanced Options for the driver will open.

10)	 Click the Document Options >> Printer Features >> Print Mode field.

11)	 The Print Mode drop-list will become active.

12)	 Choose the Print Mode that is most appropriate for the type of  job being printed. Print 
Modes are named according to media, print resolution, ink density, halftone frequency, 
and ink set.

13)	 Click OK to close the Advanced Options.

14)	 Click OK again to close the Properties dialog.

15)	 From the Print dialog, click OK to send the print job.
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Changing the Print Mode Within a Held Print Job

Once a received job is held in a queue, the choice of Print Mode can be changed within the job 
properties.

Right-click the job and 1.	
choose Properties.

The 2.	 Job Ticket Proper-
ties dialog will open.

On the 3.	 General tab, note 
the Print Mode field.

Next to the 4.	 Print Mode 
field, click the ellipsis 
button.

The available 5.	 Print 
Modes are categorized 
and named according to 
media, print resolution, 
ink density, halftone fre-
quency, and ink set. 
 
You can also quick-select 
these with the drop-down arrow. 

NOTE: If in doubt concerning an appropriate Print Mode, then a small print test is recommended.

Copying a Print Mode

If you would prefer to give custom descriptions or names to Print Modes to make it easier to 
remember which Print Modes are for what, the following methods should be used.

From the 1.	 Printers menu, choose Manage Print Modes to open the Print Mode 
Manager dialog.

From the drop-list, choose the printer model. The 2.	 Print Modes for that printer 
will then be listed.

Click the 3.	 Print Mode, such that the name is highlighted.

Along the top of the 4.	 Print Mode Manager dialog, click the Copy Print Mode 
button.

When prompted, type a meaningful name for the copy.5.	
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Editing a Print Mode

From the 1.	 Printers menu, choose Manage Print Modes to open the Print Mode 
Manager dialog.

From the drop-list, choose the printer model. The 2.	 Print Modes for that printer 
will then be listed.

Click the 3.	 Print Mode, such that the name is highlighted.

Along the top of the 4.	 Print Mode Manager dialog, click the Edit Print Mode but-
ton.

The Properties dialog for the 5.	 Print Mode will open (see Queue Properties).

Setting the Default Print Mode Within FastRIP
If there is a Print Mode that you use most often, you can set this Print Mode as your printers 
default Print Mode, saving you time in the future of having to select it each time you set up a 
print.

From the 1.	 Queue menu, choose Properties.

On the 2.	 General tab, note the selected Printer.

In the following information box, set the queue to either 3.	 Protected or Unpro-
tected mode.

To the right of the 4.	 Print Mode drop-list, click the ellipsis button to open the 
Print Mode Selection dialog.

Choose from the drop-list categories to narrow down the list of 5.	 Print Modes (i.e., 
what ink set, what resolution, etc.).

Protected Queue Mode

On the `` Queue tab, Protected mode causes all jobs received by that queue 
to use the Print Mode that is set within that queue.

For example, if you have a specific media loaded into the printer, then ``
you likewise know the precise Print Mode that should be used with that 
media.
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For a designer that does not know what media is being used, their choice ``
of Print Mode will be ignored in favor of the Print Mode that you know 
to be correct.

Unprotected Queue Mode

On the `` Queue tab, Unprotected mode assumes more responsibility 
from the designer for choosing a Print Mode that is appropriate for their 
design.

Letting the designer choose the `` Print Mode can be acceptable when they 
understand the loaded media and Print Mode choices that are available.

Marking Print Modes as Favorites

In the FastRIP 10 Queue win-1.	
dow, choose Printers >> Manage 
Print Modes. 

Next to the 2.	 Print Mode names 
column, there is a “Favorite” 
column (as indicated by the 
5-pointed star). 

To mark a 3.	 Print Mode as a fa-
vorite, click within the Favorite 
column. 

Later, when using the 4.	 Print 
Mode Selection dialog to 
choose a Print Mode, the 
“Star” column will indicate the 
Print Modes that are consid-
ered to be favorites.

Hiding Print Modes
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To prevent users from selecting the wrong Print Mode, the Print Mode Manager dialog can be 
used to hide Print Modes.

In the FastRIP 10 Queue window, choose Printers >> Manage 1.	 Print Modes.

Set all of the drop-lists to “All,” so that the full list of 2.	 Print Modes are displayed. 

Note: As a memory aid, it may be desirable to use the Favorites column to mark the Print Modes that will not be 
hidden in the subsequent steps

3.	 Next to the FavorItes column 
(the 5-pointed star), there is an 
“Approved” column (as indi-
cated by the checkmark within 
a red circle).

By default, all of the 4.	 Print 
Modes are approved.

To hide a 5.	 Print Mode, click to 
remove the circled checkmark 
within the Approved column.

Click Close to finish editing 6.	
the Print Mode Manager. 

 
In FastARTIST, only approved 
Print Modes will be selectable via 
the Print and Cut Setup dialog.

In third-party graphic software 
applications, only approved Print 
Modes will be selectable via the 
Print dialog.

Overriding the Print Mode Setting of a Print Job

When a print job is being held in the queue, its Print Mode properties can be edited prior to 
print. These edits will apply only to the given job without changing the original Print Mode.

In the FastRIP 10 Queue window, click the 1.	 Stop Queue button. This will cause 
new print jobs to be held pending.

Print a job to the FastRIP 10 Queue window.2.	
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The print job will now be listed in the FastRIP 10 Queue window.3.	

Right-click the print job and choose 4.	 Properties.

The 5.	 Job Ticket Properties dialog will open.

Any changes to these dialog settings will override the 6.	 Print Mode for this job.

Print Mode Manager Toolbar Options

Along the top of the dialog are several Toolbar buttons, which are used to rearrange, copy, edit, 
and organize a selected Print Mode. Please note that it may be necessary to create a copy of a 
Print Mode before it can be edited or moved.

Folder Editing``  refers to the folder icons that are used to indicate a 
category of Print Modes, such as from a specific manufacturer. After a 
folder has been created, your custom Print Modes can be dragged into 
the folder using the cursor.

The `` Print Mode Editing tools are Delete, Copy, Rename, and Edit. 
Before editing or moving a preset Print Mode, it is necessary to make a 
copy of that Print Mode, which can then be edited.

The `` Package Editing tools are used to export and import your custom 
Print Modes, such that they can be backed up or sent to another work-
station. When creating a package, all of the custom Print Modes will be 
listed. Choose the Print Modes that should be added to the package, and 
then click Save.
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Output Settings
Output Scheduling

Output scheduling is used to choose how jobs are scheduled when received by Visual Production 
Manager. Common scheduling scenarios are:

 For print jobs, spool print jobs as they are received, but holding the ``
spool file until the appropriate media has been loaded.

 For print and cut jobs, printing the jobs as they are received, but holding ``
the cut portion until the printed media has been loaded into the cutter.

For print-laminate-cut jobs, holding the cut portion until after the ``
printed media has been laminated.

Note: If the queue is Stopped, then all jobs are automatically placed on Hold, regardless of the Output  
        Scheduling settings.

Adding Crop Marks
Queue Pull-down Menu>>Properties>>Crop 
Marks tab

Crop Marks are standard registration symbols 
that are printed along the bounds of a print job, 
which can then be used for either cutter align-
ment, or aligning printed pieces in a layered 
assembly. 
 
By default, the crop marks are flush with the job 
edge, though this can be varied by increasing the 
offset.
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Image Output Adjustments
The following section will guide you through the process of adjusting the output, whether it is a 
density, highlight, ink or profile adjustments. You should use the “Printing a Test Page” feature to 
test your results. Refer to Printing a Test Page, later in this chapter.

Separation Curves

Queue Pull-down Menu>>Properties>>Separation Curves tab

Some printers are capable of printing a wider range of color hues for cyan, magenta and black, by 
mixing inks of the same hue together. For example, a printer might use two inks, cyan and light 
cyan, or three inks, light, medium, and dark cyan. By using two or three different inks of cyan, 
and mixing them together, the color is adjusted to give the maximum range of color density. For 
these printers, the color calibration is adjusted automatically so that the correct amount of ink is 
used for each color plane, for example cyan and light cyan.

For this example, the default print mode 
settings are shown for the selected 
printer. The straight line on the graph 
represents cyan, while the curved line 
represents light cyan. The percentages of 
cyan ink are shown in the Curve data 
section.

The x axis (horizontal line) ``
represents the percentage of ink 
input into the curve data (for 
example, to get 50% cyan).

The y axis (vertical line) repre-``
sents the percentage of ink out-
put from the particular printer 
in order to get the ink density requested through the curve data input.

The top right corner of the graph represents 0, 0 where no ink has been ``
input or output.

The bottom left corner of the graph represents 100,100 where maximum ``
ink has been output. 

NOTE: Changing the separation curves will invalidate the color adjustment settings for the corresponding 
curves. The color adjustment settings will likely require adjusting following any changes to the separation curves.
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Color Adjustment (Shadows, Midtones and Highlights)
Queue Pull-down Menu>>Properties>>CMYK Color Adjustments tab

The CMYK Color Adjustments tab adjusts the color levels of the print job. These adjustments 
are not typically required because the ICC profile is created for use with a specific calibration. As 
such, performing color adjustments will actually distort the color accuracy of the ICC profile. 
One reason for color adjustments would be to create an artistic effect.

The Shadows Slider

The Shadows Slider adjusts the black point, which is the lower end of the curve. Increasing the 
Shadows value causes the darkest parts of the print to be recognized as pure black, which also 
causes the darkest details to be lost in the shadows. 
 
Generally, the purity of printed black depends on many factors, such as how many colors are be-
ing used.

Use the mouse to adjust the Shadows slider. 
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The Midtones Slider

The Midtones Slider adjusts the gamma curve, which affects the midtones without changing the 
black and white points (the lower and upper ends of the curve, respectively). 

Raising the midtone of a color plane results in laying down less ink on the media for that color.

Use the mouse to adjust the Midtones slider
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The Highlights Slider

The Highlights Slider 
adjusts the white point, 
which is the upper end of 
the curve.

Lowering the Highlights 
value causes the lightest 
parts of the print to be 
recognized as pure white, 
which causes the lightest 
details to be lost in the 
highlights.

Use the mouse to adjust 
the Highlights slider.

 
 
 

Multi-adjustments

When both Highlights 
and Shadows are adjusted, 
the contrast between light 
and dark areas will be 
more pronounced. How-
ever, light and dark details 
will be lost as those tones 
were forced to either 0% 
or 100%. 
 
The Highlights and 
Shadows controls are use-
ful for preserving details 
on printers that are inca-
pable of differentiating 
the darkest and lightest 
pixels accurately. 

By adjusting the white 
and black point values, 
more of the image details will fall within the range that the printer is capable of rendering. 
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Density Curve

The Density Curve is used to 
set densitometer values for each 
color plane.

This curve is similar to using 
the X-Rite colorimeter, though 
lower-cost hand held devices 
may instead be used, and the 
data must be entered manually.

Image Adjustments

Queue Pull-down 
Menu>>Properties>>Image Adjust-
ments tab

The Image Adjustment tab provides 
some additional controls for improv-
ing the image quality of the printed 
output.

Image Sampling

The Image Sampling slider is used to upsample images, such that their resolution meets a mini-
mum percentage of the printer resolution (i.e., the resolution set in the print mode).

For example, suppose that the Image Sampling slider is set to 10%. If the printer resolution is 
set at 720 dpi, then 10% of 720 is 72 dpi. So for an image of less than 72 dpi, it will be auto-
matically upsampled to 72 dpi before printing. If an image were already 72 dpi or more, then no 
upsampling will be performed for that image.

For designs that contain two-or-more images of varying resolutions, the Image Sampling slider 
is a convenient means of automatically enforcing a minimum image resolution. However, note 
that the Image Sampling slider is capped at 40% to avoid losing image definition (i.e., upsam-
pling by an excessive amount risks losing fine detail within the image). Though upsampling im-
ages will require more processing time, the trade-off is greater uniformity in print quality.
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Sharpen / Blur

The job may be set to either Sharpen or Blur the printed images.

The `` Sharpen setting is useful to compensate for devices that otherwise 
produce mediocre output.

The `` Blur setting is useful as a means of creating the effect of a painted 
image.

Image Saturation

The saturation is the colorfulness of an area in consideration of its brightness level. For example, 
as a color falls under increasing levels of shadow, the color appears darker, even though its satura-
tion remains constant. The Image Saturation slider is used to create an artistic touch. As with 
the tonal settings, the saturation may be applied to each color plane separately.

Increasing the Saturation produces a more colorful print.``

Decreasing the Saturation produces a more grayscale print. ``

Max Ink Tab

Queue Pull-down Menu>>Properties>>Max Ink tab

Ink Volume Adjustments

The ink volume is the physical quan-
tity of ink that is applied when print-
ing, which is regulated by the MaxInk 
setting within the print mode. Each 
print mode is assigned a MaxInk 
setting (Fig. 38) that is appropriate 
for the inks and media that the print 
mode was designed for. Sometimes the 
MaxInk settings need to be adjusted 
when the print mode is considered a 
“close” match for a substitute media. 
For example, a print mode for glossy 
white media (from one manufacturer) 
can be sometimes be appropriate for 
glossy white media (from another 
manufacturer). In such a case, the 
Max Ink setting would be adjusted to 
compensate for the slightly different 
absorbency of the substitute media.
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The `` Maximum Ink Level setting is the target ink volume that will be 
used when ink volume needs to be reduced.

The `` Blend In Ink settings (From, To) are the range of inks for which 
the Max Ink setting will be enforced. If the volume of ink falls within 
this range, then the volume will be adjusted to below the Maximum Ink 
Level. Though the ink volume is reduced, the proportion of blended inks 
will be maintained to avoid harsh gradient transitions.

The graph (within the dialog) depicts the `` Maximum Ink Level and 
Blend In Ink settings. The horizontal axis represents the Total Ink Vol-
ume Requested, and the vertical axis represents the Total Ink Volume 
Delivered.

For the range of the graph that falls within the `` Blend In Ink bounds, 
note that the graph typically becomes a horizontal line to indicate how 
ink volume will be attenuated to the Maximum Ink Level.

Note that the graph has adjustment handles that can also be used to modify the Max Ink settings.

ICC Profiles

Queue Pull-down 
Menu>>Properties>>ICC Profile tab

The ICC Profile tab indicates the 
color profiles used in the RIP process. 
During the RIP process, the input and 
output profiles are used to preserve 
color quality between the original 
design and the resulting print.

The input profiles represent ``
the colors as seen when dis-
playing the design on a moni-
tor.

The output profile represents ``
the colors that the printer is 
capable of reproducing. 
 
 
 

NOTE: We do NOT recommend changing the default settings unless you are familiar with how ICC profiles  
         work. 
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NOTE: If all else fails, return settings to the default settings; mark down the default profile names (i.e. Cadlink  
          Unified RGB.icm) for each adjusted profile. The profiles are located in a folder on your main hard drive where  
         FastRIP was originally installed. For example: Local Disk C:/FastRIP/System/clinks. If you are using FastRIP in 
conjunction with FastARTIST, the FastRIP folder will be located inside the FastARTIST 2 (or version number) folder.

Printing a Test Page
Under the Printers menu, choose Print Test Page.

The Print Test Page dialog provides several types of target charts for testing your printer output. 
More than one test page can be printed at a time. Check each test page that is required and then 
click OK.

Quick Print Test

One or more of the charts from the Print Test Page dialog can be designated for the Quick Print 
Test. The charts are selected as follows:

Under the Printers menu, choose Print Test Page.1.	

Select each chart that should be part of the test (Use [Shift] and [Ctrl] to select 2.	
multiple charts).

Tick the “Use current selection for Quick Print Test” checkbox.3.	

Click OK.4.	
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Print Test Page Options

From the Printers menu, choose Print Test Page to print the 
selected charts.

Test Page

This Test Page is specifically designed to help recognize 
changes due to tonal adjustments. For example, the indi-
vidual tints can be checked by referring to the tint percentage 
boxes, whereas the overall balance is checked by looking at 
the color graduation. For advice concerning how to interpret 
this test page, please refer to the Color Adjustments settings 
that are available through the Queue Properties. 

Ink Limit Target

The Ink Limit Target is primarily used by the Advanced Calibration Wizard to determine a good 
“starting point” with respect to ink limit settings when creating a new media profile. 
 
For example, here is how the Ink Limit Target is used in the Advanced Calibration Wizard to 
profile new media:

1.	 Begin by choos-
ing an existing 
print mode that is 
“close” to what is 
desirable for the 
loaded media and 
inks.

2.	 This will be your 
“starting point” for 
creating the new 
print mode.

3.	 In the Advanced Calibration Wizard, proceed to the Print Mode Options page 
and indicate the “Starting point” print mode.

4.	 Click Next to proceed to the Print Calibration Chart page.

5.	 Click the Adjust Ink Limits button to open the Adjust Ink Limits dialog.
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6.	 Each of the CMYK color channels is represented by the percent ink that can 
print. By default, each channel is set at its maximum 100%. 

7.	 Click the Print Test Chart button. The Ink Limits Chart will be printed to the 
FastRIP 10.

8.	 After the Ink Limits Chart has been printed, inspect the quality of the chart. 
Each swatch should contain three white rectangular hairlines.

9.	 If the white hairlines are not visible for a given range of tints, then this is an 
indication of bleeding that needs to be resolved by reducing the ink volume.

10.	Back in the Adjust Ink Limits dialog, reduce the ink volume for the color 
channel that is producing bleeding.

11.	Click the Print Test Chart button to print another Ink Limits Chart.

12.	Repeat steps (8) through (11) as necessary to obtain a good quality chart.

13.	When good quality has been obtained, click OK to close the Adjust Ink Lim-
its dialog.

14.	Proceed with the remainder of the Advanced Calibration Wizard.

When examining the quality of the Ink Limit Target, inspect the three ``
white rectangles that should be present within each swatch.

For swatches that do not have white rectangles, this is an indication of ``
bleeding that needs to be compensated for by reducing the ink volume.
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Each row of the chart represents the tints of a particular color channel, or ``
a combination of channels.

The hue of the swatches is less important than inspecting the quality of ``
white rectangles that should be present within each swatch.

The top four rows consist of your CMYK swatches, varying from 100% ``
to 5% tint.

The CMY row indicates the tints produced using only the CMY ``
channels.

The MY, CY, and CM rows each consist of only the two channels com-``
bined, which are then varied from 100% to 5% tint.

For the rows “MY+C” through “CM+K,” in each case there are the two ``
channels combined, with the third varied from 100% to 5% tint.

The final row, CMYK, indicates the tints produced using all four CMYK ``
channels.

 
 Max Ink Page

The Max Ink Page is used to help identify the 
best Max Ink setting for your printer. By compar-
ing this chart when printed at different Max Ink 
levels, the optimum Max Ink can be determined 
simply by choosing the chart that looks best for 
the given media. This choice is based entirely 
upon your own judgment and preference. The 
Novice Calibration Wizard, which includes a facility for printing a series of these Max Ink tar-
gets, also includes comments to help you make an informed choice.

CMYK Test Page

The CMYK Test Page is an older target for internal use by 
CADlink Tech Support. For a newer target, please refer to the 
Profile Test Chart.

The gradient bars along the bottom are a useful indica-``
tor of problems in grayscale gradient (should be uni-
form).

For the various images, there are many fine details that ``
can become blurred if there is not enough ink being laid 
down.

Likewise, the image colors are used to confirm that good ``
saturated red, orange and yellow are being produced. 
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Agfa IT8 Target

The Agfa IT8 Target is a legacy target for internal use by 
CADlink Tech Support. The original use of this target was to 
produce ICM files. In troubleshooting output, CADlink Tech 
Support may request that you print this test page.

 

Profile Test Chart

The Profile Test Chart is recommended for testing your media 
profiles (i.e. print modes).

The gradient bars along the bottom are a useful indicator ``
of problems in grayscale gradient. The gradients should 
remain uniform.

For the various images, there are many fine details that ``
can become blurred if there is not enough ink being laid 
down.

Likewise, the image colors are used to confirm that good ``
saturated red, orange and yellow are being produced.

Profile Test Chart Extended

The Profile Test Chart Extended includes the Profile Test Chart and additional testing sections, as 
follows:

A selection of PANTONE® color swatches.``

A collection of progressively smaller ``
sentences, which are used to confirm 
that small text details are not being 
lost.

A grayscale image of a watch, which ``
is used to verify that details are not 
becoming blurred.

Several spiral patterns that are part of ``
a line test to verify that line fragments 
are not being created. 
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Output Speed
There may be some concern about the speed of printing when using an inkjet printer because 
inkjet’s typically don’t have as much memory as a laser printer or dry film system. Don’t be con-
cerned. FastRIP uses your computer’s memory when “RIPing” the image. If you print to a 17” 
x 22” piece of film, the actual printing time may take up to nine minutes. That may seem long, 
but FastRIP actually processes the image much faster than RIP’s that are built into laser printers. 
Therefore, the actual rasterizing of the image is much faster and technically speed IS NOT an 
issue when printing with an inkjet.
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Troubleshooting
Frequent Troubleshooting Topics

Test Files 
The FastRIP CD contains a folder with CMYK test files that will help you determine how well 
you can print halftone dots. Instructions for using these tests can be found in the Readme.txt file 
contained in this folder.

RIP Doesn’t Print 
If FastRIP doesn’t print, or if you continue to get PostScript code output even after you cancel 
a print routine, you may need to re-install the program or the printer driver. It is possible the 
program or printer drivers have become corrupted.

Re-Installing the Printer Driver

Open FastRIP and go to Printers > Manage Printers. Uncheck the box under the Control Panel 
for the Fast T-Jet printer and click Close. Return to the Manage Printers screen and check the box 
under the Control Panel for the Fast T-Jet printer. Click Close.

Other Dongle or RIP Conflicts

If you are printing to other devices that use a dongle, or if you have another RIP installed for 
other applications, there may be conflicts. Try removing other dongles or disabling other RIP’s 
before printing. This should resolve any conflicts.

Check Your Computer’s Resources

Make sure you have enough RAM to run FastRIP. The minimum System Requirements are listed 
on page 10 of this Manual. If you find that jobs are taking too long to process or just not pro-
cessing at all, you may have to add RAM to your PC.
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Start FastRIP BEFORE Sending a Print Job

If you get errors when FastRIP opens while a job is being sent from within an application, try 
opening FastRIP before you print to it. When you open the RIP it will remain idle until a Print 
command is given.

When All Else Fails....
Certain devices and computers like to see things turned on in a specific order. Generally, you 
should turn the printer ON before you boot your computer. TURN EVERYTHING OFF AND 
UNPLUG EVERYTHING FROM THE WALL OUTLET. Computers and printers still receive 
current when they are shut off, but unplugging them prevents any current from reaching them. 
As a last resort, this should clear out any “bugs” still left.

Prints show random thin HORIZONTAL lines through image or INK lines 
appear on the outside of the image.

90% of the time the clear horizontal lines are caused by clogged nozzles on the printer. Try the 
following steps to see if you can get rid of the clear lines.

You may have a Parallel port issue with the port sending data too fast for ``
your printer to output. This is a communication problem that can be 
fixed by slowing down the data transfer rate of the parallel port.

If you are using a USB connection, or you have changed the data rate and ``
there are still thin horizontal lines in the image, run 4 or 5 head cleanings 
and do a test print to see if the problem is fixed.

If the horizontal lines remain, print a `` Nozzle Check on film using the 
regular Epson driver. Check to see if there are any breaks in the black. 
 
If there are breaks in the black, run 3 or 4 head cleanings for the black.

If you did not notice any breaks in the black pattern created by a `` Nozzle 
Check, create a small, solid black box in a graphics program, like Photo-
shop or FastARTIST.

Print this box on film through FastRIP. If you still notice horizontal lines, ``
run 3-4 more head cleanings and print out the black box again on film. If 
the clear lines improve, try running more head cleanings until the prob-
lem is resolved.

If the clear lines remain visibly unchanged when the second black box is ``
printed, the nozzles are clogged with dust/debris/dry ink. You will need to 
have your printer professionally cleaned by an Authorized Epson Repair 
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Technician. They may be able to clean the nozzles or they may have to 
replace the print head. When they replace the print head, it replaces the 
nozzles on the printer. 
 
To locate a service technician near you, contact Epson Support at (562) 
276-7202.

Can’t find RIP driver or access advanced print options

Open the FastRIP program. In the toolbar, go to Printers > Manage Printers.

In this window, ensure the box for your printer underneath the heading Control Panel is 
checked. This will put your RIP driver into your control panel so you can access the advanced 
printer options through your graphics program. Click on Ok. You should now have the RIP 
driver available.




